
বাাংলাদেশ কারিগরি রশক্ষা ববার্ড, ঢাকা
েবিসক 

সেষয় : কম্পিউটাি অসিি অযাসিককশন

1. কম্পিউটাি কী?
১) উত্তি: কম্পিউটাি একটট ইকেকেসনক সডভাইি ো যন্ত্র। কম্পিউটাি শকেি অর্ থ গণনাকািী যন্ত্র, যা পূকে থসেসিত সনকিথশনা
অনুিাকি (যাকক বরাগ্রাম েকে) উপাত্ত (Data) িংিক্ষণ কিকত পাকি,রক্রিয়াজাত কিকত পাকি ও তর্য ( Information) রিশ থন 
কিকত পাকি। রাধসমকঅেস্থায় এটট শুধু গননাি কাকজ েযেহাি কিা হত। েতথমাকন কম্পিউটাি সিকয় গাসণসতক,বযৌসত্তক ও
সিন্ধান্তমুেক কাজ কিা যায়।
2. আধুসনক কম্পিউটাকিি জনক বক?

২)উত্তি:চােি থ েযাকেজ
3. চােি থ েযাকেজকক কম্পিউটাকিি জনক েো হয় বকন?

৩)উত্তি: সডিাকিে ইক্রিন ততসি কিাি মাধযকম চােি থ েযাকেজ কম্পিউটাি ততসিি িুিষ্ট ধািণা বিন, তাই তাকক কম্পিউটাকিি
জনক েো হয়।
4. তর্য রযুক্রি েেকত কী েুঝায়?

৪)উত্তি: তর্য িংগ্রহ, এি িতযতা ও তেধতা যাছাই, িংিক্ষণ, রক্রিয়াকিণ, আধুসনকীকিণ, পসিেহন, সেতিণেযেস্থাপনাি িাকর্
িংসিষ্ট রযুক্রিকক েো হয় তর্য রযুক্রি।
5. োংোকিকশি কাসিগসি সশক্ষা বোডথ বকান িাকে রসতষ্ঠাসত হয় এেং বকান বজোয় অেসস্থত?

৫)  উত্তি: ১৯৫৪ িাকে ১নং িংিিীয় আইন েকে এটট রসতটষ্ঠত হয়। এটট ঢাকা বজোয় অেসস্থত।

6. পৃসর্েীি রর্ম কম্পিউটাি বরাগ্রাম িচসয়তা বক?

৬)উত্তি: বেসড এডা অগাস্টা
7. কম্পিউটাি স্মসৃত রধানত কত রকাি?

৭) উত্তি: িুই রকাি।i)Primary Memory ii) Secondary Memory

8. ি যাম কী?
৮)উত্তি: মািািকোকডথি িাকর্িিািসি িংযুি বয স্মসৃতকত পঠন এেং সেিন িুটট কাজই িিন্ন কিা যায়, বি স্মসৃতককি যাম স্মসৃত
েো হয়। এই স্মসৃত একটট অস্থায়ী স্মসৃত।
9. িম কী?
৯)উত্তি: রধান স্মসৃতি এই অংশটট স্থায়ী, অপসিেতথনীয় ও অধ্ধংিাত্বক। কম্পিউটাি ততসি কিাি িময় এই স্মসৃতকতসকছু
বরাগ্রাম ঢুসককয় বিওয়া হয়। কম্পিউটাি েন্ধ কিকেও এই স্মসৃতকত িসক্ষত বকান তর্যমুকছ যায় না। এটট একটট পঠন স্মসৃত।
10. কম্পিউটাকিি স্মসৃত রধানত কয় রকাি?

১০)  উত্তি: কম্পিউটাকিি স্মসৃত রধানত ২ রকাি, যর্া i) রধান ো রাইমাসি বমমসি  ii) িহায়ক ো বিককন্ডাসি বমমসি।
11. ৫টট হাডথওয়যাি যকন্ত্রি নাম বেি?

১১)  উত্তি: i)Mouse, ii) Keyboard, iii) Monitor, iv) Printer, v)Speaker

12. সরন্টাি কী?
১২)  উত্তি: সরন্টাি একটট আউটপুট সডভাইি, কম্পিউটাকিি তর্য রক্রিয়াকিকণি িোিেকক সেসিত আকাকি পাওয়াি জনয
সরন্টাি েযেহাি কিা হয়।
13. মসনটি কাকক েকে?

১৩)  উত্তি: কম্পিউটাকিি যােতীয় কায থিমকক রিশ থকনি জনয বয পিথােযেহাি কিা হয়, তাকক মসনটি েকে।
14. কম্পিউটাকিি মুে অংশ গুকো সক সক?

১৪)  উত্তি: i) input Unit ii)Output Unit iii)CPU Unit

15. Bios কী?
১৫)  উত্তি: Basic input Output System এি িংসক্ষপ্ত রূপককই Bios েোহয়।এটট মূেত িকম িংিসক্ষত একটট িিটওয়যাি।
16. ককয়কটট কম্পিউটাি এসি ভাইিাি িিটওয়যাকিি নাম বেি I

১৬)  উত্তি: Kaspersky, Avira, Avast, Norton ইতযাসি।
17. Scanner- এি কাজ কী?
১৭)  উত্তি: Scanner এি মাধযকম সেসভন্ন রকাি ছসে ো তর্য কম্পিউটাকি অেকজক্ট আকাকি ইনপুট কিা হয়।
18. বপন ড্রাইভ এি কাজ সক?

১৮)  উত্তি: তর্য বস্টাি ককি িািা।
19. চািটট ইনপুট সডভাইকজি নাম সেি?

১৯)  উত্তি: i) Keyboard, ii) Mouse iii) Scanner iv) Joystick



 

 

20. Anti-Virus িিটওয়যাকিি কাজ সক? 

২০)  উত্তি: Anti-Virus হে কম্পিউটাকিি ভাইিাি রসতকশাধক। কম্পিউটাকিি বরাগ্রামিমূহকক ভাইিাি মুি কিাি জনয এেং 
ভাইিাকিি সেরুকে রসতকিাধ গক়ে বতাোি উপকযাগী পসিকেশ িটৃষ্ট কিাই এি কাজ। েতথমাকন এ জাতীয় অকনক বরাগ্রাম পাওয়া 
যায়।   

21. Pen Drive বক I/O েো হয় বকন? 

২১)  উত্তি: বপন ড্রাইভ কম্পিউটাকিি একটট িহায়ক বমকমাসি সহিাকে েযেহাি কিাহয়। এি িাহাকযয ডাটা বযমন ইনপুট কিা 
যায় বতমসন আউটপুটকৃত ডাটা বস্টাি কিা যায়,সেধায় এই িহায়ক বমকমাসি একই িাকর্ ইনপুট ও আউটপুকটি কাজ ককি। এ 
কািকণ বপনড্রাইভকক I/O সডভাইজ েো হয়। 

22. OMR কী? 

২২)  উত্তি: এটট একটট সেকশষ ধিকনি ইনপুট সডভাইি। সেকশষ সশকটি মাকথ বক পাঠ ককি সনসিথষ্ট িিকমি ডাটা ততসি ককি।  

23. অযাসিককশন িিটওয়যাি কী? 

২৩)  উত্তি: েযেহাসিক িমিযা িমাধান ো তর্য রক্রিয়াকিকণি জনয েযেহৃত বরাগ্রামকক েযেহাসিক বররাগ্রাম ো অযাসিককশন 
িিটওয়যাি েো হয়। 

24. অপাকিটটং সিকস্টম কী? 

২৪)  উত্তি: অপাকিটটং সিকস্টম কসতপয় বরাগ্রাকমি িমাহাি, যা বকান কম্পিউটাি সিকস্টকমি সিকিাি থ িমূহকক সনয়ন্ত্রণ, 

পয থকেক্ষণ ও তত্ত্বােধান ককি। 

 

25. কম্পিউটাি িিটওয়যাি কী? 

২৫)  উত্তি: বকান িমিযা িমাধাকনি জনয কম্পিউটাকিি ভাষায় ধািাোসহক ভাকে সেসিত িুশঙৃ্খে কত গুকো সনকিথকশি 
িমটষ্টকক বরাগ্রাম ো িিটওয়যাি েকে।   

26. হাডথওয়যাি যসি কম্পিউটাকিি বিহ হয় তাহকে িিটওয়যাি কম্পিউটাকিি কী? 

২৬)  উত্তি: রাণ   

27. Shut Down কমাকন্ডি কাজ কী? 

২৭)  উত্তি: Windows Operating System হকত বেি হওয়াি জনয এই কমান্ডেযেহাি কিা হয়।   

28. অপাকিটটং সিকস্টকমি কাজ সক? 

২৮)  উত্তি: Operating System কম্পিউটাকিি Hardware বক িচে ককি এেং Hardware এেং Software এি মকধয িংকযাগ 

স্থাপকনি কাজ ককি র্াকক।  

2৯. হাডথওয়যাি যসি কম্পিউটাকিি বিহ হয় তাহকে িিটওয়যাি কম্পিউটাকিি কী? 

২৯)  উত্তি: রাণ   

30. সেট, োইট কী? 

৩০)  উত্তি: েীট- োইনািী নাম্বাি পেসতকত েযেহৃত অংক ০ (শুনয) এেং ১(এক) বক সেট েকে। োইট- আট সেকট এক োইট হয়। 
এরূপ ৮ সেকটি বকাড সিকয় বয বকান েণ থ,অঙ্ক ো সেকশষ সচহৃকক রকাশ কিা হকয় র্াকক। 

 

31. কত সককোোইকট ১ বমগাোইট? 

৩১)  উত্তি: 1024 KB = 1MB   

32. িেকচকয় িিে িংিযা পেসত হকে সক? 

৩২)  উত্তি: োইনাসি।   

33. মাইকিািিট ডি কী? 

৩৩)  উত্তি: ডি শকেি অর্ থ সডস্ক অপাকিটটং সিকস্টম। ইহা একটট েণ থসভক্রিক অপাকিটটং সিকস্টম। 

34. DOS ও Windows কী? 

৩৪)  উত্তি: ডি একটট েণ থসভক্রিক অপাকিটটং সিকস্টম। উইকন্ডাজ একটট সচত্রসভক্রিক অপাকিটটং সিকস্টম। 

35. Windows কী? 

৩৫)  উত্তি: উইকন্ডাজ একটট সচত্র সভক্রিক অপাকিটটং সিকস্টম। এই অপাকিটটং সিকস্টম সচকত্রি আইকন উপি সিক ককি কাজ 
কিা যায়। 

 

36. Windows XP কী? 

৩৬)  উত্তি: কম্পিউটাি পসিচােনাি জনয একটট সিকস্টম িিটওয়যাি। 

37. File শকেি অর্ থ সক ো িাইে কাকক েকে? 

৩৭)  উত্তি: যিন বকান ডকুকমন্ট বক বকান নাম সিকয় িংিক্ষণ কিা হয়, তিন তাকক িাইে েকে। 

38. Folder (বিাল্ডাি) কী? 

৩৮)  উত্তি: বিাল্ডাকিি মকধয িাইে িািা হয়। তাছা়োও বিাল্ডাকিি মকধয বিাল্ডািও িািা যায়, একক িাে-বিাল্ডাি েকে। 

 

 

 

39. Dialog Box কী? 



 

 

৩৯)  উত্তি: Text এেং Message  িম্বসেত েক্স বযিাকন রকয়াজনীয় সনকিথশনা বযমন- Ok, Cancel, Save ইতযাসি তর্য র্াকক। 

40. কী-বোকডথি কত গুকো কী র্াকক? 

৪০)  উত্তি: ১০৪টট ো কিনও কিনও এি বচকয়ও বেসশ র্াককত পাকি। 

 

41. িিটওয়যাি কাকক েকে? 

৪১)  উত্তি: িিটওয়যাি কম্পিউটাকিি ভাষায় Soft শকেি অর্ থ নিম অর্ থাৎ হাতদ্বািা বছা োঁয়া যায় না, আি Ware শকেি অর্য 
িুক্ষ। কম্পিউটাি চাোকনাি িময় কম্পিউটাকক বয িমস্ত সনকিথশনা রিান কিা হয়, যাকিিকক বছা োঁয়া যায় না, বি িে সনকিথশনাি 
িমটষ্টকক িিটওয়যাি েকে। 

42. িিটওয়যািকক কয় ভাকগ ভাগ কিা হকয়কছ ও সক সক? 

৪২)  উত্তি: িিটওয়যাি িাধািণত িুই রকাি। যর্া: i) সিকস্টম িিটওয়যাি ii)অযাসিককশন িিটওয়যাি I 
43. অযাসিককশন িিটওয়যািকক কয়ভাকগ ভাগ কিা হকয়কছ ও সক সক? 

৪৩)  উত্তি: অযাসিককশন িিটওয়যািকক ককয়ক ভাকগ ভাগ কিা হকয়কছ যর্া: ১)কাস্টমাইজড িিটওয়যাি, ২) মাসিসমসডয়া 
িিটওয়যাি, ৩) গ্রাসিকযাে িিটওয়যাি, ৪)ইন্টািকনট বেইিড িিটওয়যাি। 

44. সিকস্টম িিটওয়যাি সক? 

৪৪)  উত্তি: বয িিটওয়যাি কম্পিউটাকিি হাডথওয়যািকক িচে ককি উহা পসিচােনায় িাহাযয ককি বিই িিটওয়যািকক সিকস্টম 
িিটওয়যাি েকে। 

45. অযাসিককশন িিটওয়যাি সক? 

৪৫)  উত্তি: বয িিটওয়যাি েযেহািকািীি েযেহাসিক কাকজি সনসমকত্ত োসণক্রজযক সভক্রিকত ততসি কিা হয়, তাকক অযাসিককশন 
িিটওয়যাি েকে। 

 

46. কাষ্টমাইজড িিটওয়যাি কাকক েকে? 

৪৬)  উত্তি: এই িিটওয়যাি সেসভন্ন জাতীয় সেকনািনমূেক িিটওয়যাি, বযমন-Game,Fun ইতযাসি। 

47. মাসিসমসডয়া িিটওয়যাি কাকক েকে? 

৪৭)উত্তি: এই িিটওয়যাকিি মাধযকম অসডও ও সভসডও গান শুনকত পাই,তা হে মাসিসমসডয়া িিটওয়যাি। বযমন- 

JetAudio, Superdecoder, Xingplayer, KMPlayer, Windows MediaPlayer ইতযাসি 

48. গ্রাসিকযাে িিটওয়যাি কাকক েকে? 

৪৮)  উত্তি:কয িিটওয়যাি Graphics এি কাজ কিকত িাহাযয ককি,তাকক গ্রাসিকযাে িিটওয়যাি েকে। বযমন-Adobe 

Photoshop, Adobe Illustrator 

49. ইন্টািকনট বেইিড িিটওয়যাি কাকক েকে? 

৪৯)  উত্তি: বয িিটওয়যাি এি মাধযকম ইন্টািকনকটি কাজ কিা হয় তাকক ইন্টািকনট বেিড িিটওয়যাি েকে। বযমন – 

Mozilla Firefox, Google Chrome, InternetExplorer, UC Browser ইতযাসি 

50. িাম থওয়যাি (Firmware) কাকক েকে? 

৫০)  উত্তি: িাম থওয়যাি হকে এমন একটট বরাগ্রাম, যাকক কম্পিউটাি ততসিি িমকয় কম্পিউটাকিি বমমসিকত িম-এ স্থায়ীভাকে 
ধািণ ককি বিয়া হয়। এ জাতীয় বরাগ্রাম বকেে মাত্র কম্পিউটাকি এি পিথায় বিিা যায়। কম্পিউটাি েযেহািকাসি কতৃ থক এ 
জাতীয় বরাগ্রাকমি বকানরূপ পসিেতথন ো িংকশাধন িুকযাগ র্াকক না।  
বযমন ক) কম্পিউটাি বমমসিরিশ থন ি) সনকিথশনােসে ো ডাটা বোড কিা ও গ) বরাগ্রাম িান কিা। 

 

51. Save ও Save As এি মকধয পার্ থকয কী? 

৫১.  উত্তি: বকান ডকুকমন্ট ততসি কিাি পি বিটটকক রর্ম োকিি মত বিভ কিকত চাইকে Save as েযেহাি কিা হয়, অর্ো- 
বিভ কিা িাইেকক সভন্ন নাকম িংিক্ষন কিাও যায়। পূকে থি বকান ডকুকমন্ট এ নতুন বকান অেকজক্ট িংকযাগ কিাি রকয়াজন 
হকে তিন save েযেহাি কিা হয়। 

52. Merge Cells েেকত কী েুঝায়? 

৫২.  উত্তি: একাসধক বিে একক্রত্রত কিা । 

53. বিাল্ডাকিি সকছু িংিযক িাইে সনে থাচন কিাি ধাপগুকো ধািাোসহক ভাকে সেিা যায় সকভাকে? 

৫৩.  উত্তি: Folder এি উপি Mouse পকয়ন্টাি বিকি Right ButtonClick>Open>Double Click ককি Ctrl Key বচকপ বয বয 
িাইে সনে থাচন কিািরকয়াজন বিই িাইকেি উপি মাউি সিকয় সিক ককি ককি সনসিথষ্ট িাইেগুকো সনে থাচন কিাযায়। 

54. ডকুকমকন্টি সকছু অংকশ বোল্ড কিাি কমান্ড সেি? 

৫৪.  উত্তি: Shift+Arrow Key এেং Ctrl+B 

55. ইংকিজী শকেি রসতশে সকভাকে বেি কিকত হয়, সেি? 

৫৫.  উত্তি: Tools Menu> Spelling and Grammar> Spelling & Grammar- এ রসতশে বিিা যাকে। 

 

 

 

 

56. Ms Word এ সকভাকে Page Setup/ Margin Setup কিা যায়, তা েণ থনা কি? 



 

 

৫৬.  উত্তি: File> Page Setup >Page Setup Dialog Box বর্কক Left,Right, Top, Botton Option রকয়াজনীয় মাক্রজথন সিকেক্ট 
ককি ওকক সিকত হকে। অর্োআপকডট ভাি থকন: Page Layout Reborn পাওয়া যাকে এই অপশন গুসে। 

57. Ms Word এ বমইে মাজথ েকে কী বোঝায়? 

৫৭.  উত্তি: একই সচটঠ, বমইসেং বেকভে ো সেজ্ঞসপ্ত যসি সেসভন্ন টঠকানায়সভন্ন সভন্ন েযক্রি ো রসতষ্ঠাকনি সনকট পাঠাকনাি 
রকয়াজন হয়, তিন উি সচটঠিিাকর্ সভন্ন সভন্ন টঠকানাকক একত্র ককি িুে অল্প িমকয় পূণ থাঙ্গ সচটঠ গঠন কিািপেসতকক বমইে 
মাজথ েকে। অর্ো, একটট সচটঠ সেসভন্ন টঠকানায় পাঠাকনাই হে বমইে মাজথ। 

58. Ms Word এ  মযাকিা েযেহাকিি িুসেধা িমূহ উকেিয কি? 

৫৮.  উত্তি: ক)এ কাজ োি োি কিাি রকয়াজন হয় না। ি) কম িমকয় অকনক বেসশকাজ িিুন্ন কিা যায়। গ)সনভূথেভাকে 
কাজ িিািন কিা যায়। 

59. Column Break কিাি জনয কী -বোডথ বর্কক রিত্ত কমান্ড কী? 

৫৯.  উত্তি: ALT+I, B,C,ENTER 

60. Macro কী? 

৬০.  উত্তি: একটট কমাকন্ডি িমটষ্টকক Macro েকে। 

61. Recycle bin এি েযেহাি সেি? 

৬১.  উত্তি: Delete কিা Data িংিক্ষণ কিা ও পূনিায় সিসিকয় বিয়া। 

62. Ctrl + Z কমাকন্ডি কাজ সেি? 

৬২.  উত্তি: Undo কিাি জনয। 

63. কী বোডথ বর্কক রিত্ত সরন্ট কমান্ডটট বেি? 

৬৩.  উত্তি: Ctrl + P64. File Menu Bar এ েযেহৃত চািটট Sub- Menu এি নাম সেি? 

৬৪.  উত্তি: Save, Save As, Print, Page Setup, New file, Open File. 

65. Replication এি কাজ কী? 

৬৫.  উত্তি: Table এি ছায়া বটসেে ততসিি জনয িাধািণত েযেহৃত হকয় র্াকক। 

 

66. একটট Folder ততসি কিাি ধাপ বেি? 

৬৬.  উত্তি: Mouse এি Rightোটন সিক- New সিক- Folder এ সিক ককি বিাল্ডাি এি একটট নাম সিকয় িা োঁকা জায়গায় 
সিক কিকত হকে। 

67. ডকুকমন্ট সরন্ট কিাি ধাপগুকো উকেি কি? 

৬৭.  উত্তি: File- Print- Print dialog box হকত রকয়াজনীয় অপশন সিকেক্টককি ওকক োটকন সিক। 

68. Paste এ শটথকাটথ কমান্ড কী? 

৬৮.  উত্তি: Copy Command: Ctrl +C, Paste Command: Ctrl + V 

69. Ms Word এ কোম বকান বমনুি অধীকন? 

৬৯.  উত্তি: িিকমট বমনুি অসধকন। 

70. Page Setup কাকক েকে? 

৭০.  উত্তি: এমএি অসিি এি বকান বরাগ্রাকম বকান ডকুকমন্ট ততসি কিাি পিকিটা সরন্ট সিকত হকে, বকান আকাকিি পৃষ্ঠা 
েযেহাি হকে, পৃষ্ঠাি মাক্রজথন কতটুকুহকে এিে সকছুকক এককত্র বপজ বিটআপ েো হয়। 

 

71. Header কাকক েকে ো কী? 

৭১.  উত্তি: রসতটট পৃষ্ঠাি মাক্রজথকনি উপকিি অংশ। 

72. একটট English  Font এেং একটট Bangla Font এি নাম বেি। 

৭২.  উত্তি: েহুে রচসেত ইংসেশ িন্ট হে Times New Roman এেং Bangla Fontহে  SutonnyMJ 

73. িাইে বিভ কিকে সক ঘকট? 

৭৩.  উত্তি: িাইে বিভ কিকে একটট সনসিষ্ট নাকম বকান একটট ডকুকমন্টকক িংিক্ষনকিা যায়। 

74. Bijoy Keyboard এি Bangla to English ো English to Bangla কিাি শটথকাটথ কী বকানটট? 

৭৪.  উত্তি: Ctrl + Alt + B 

75. Footnote কী? 

৭৫.  উত্তি: রসতটট পৃষ্ঠাি সনকচ টটকা বেিা হকো িুটকনাট। 

76. MS Word এ Text Alignment কয় রকাি ও সক সক বেি। 

৭৬.  উত্তি: ৪ রকাি।যর্া: Left, Centered, Right, Justified 

77. Print Preview এি কাজ কী? 

৭৭.  উত্তি: বকান ডকুকমন্টকক Print কিাি পূকে থ তা বিিাি জনয PrintPreview েযেহৃত হয়। 

78. MS Access Program এ export এি কাজ কী? 

৭৮.  উত্তি: এমএি অযাকক্সি হকত একক্সে এ ডাটা কসপ কিা। 

79. সেজয় ৫২ বক ততসি ককিকছন? 

৭৯.  উত্তি: বমাস্তিা জব্বাি। 



 

 

80. MS Word এি Menu Bar এ েযেহৃত Menu গুকোি নাম বেি? 

৮০.  উত্তি: File, Edit, View, Insert, Format, Tools, Table, Window,Help 

81. Document Close কিাি কী-বোডথ কমান্ড বেি? 

৮১.  উত্তি: Ctrl + F4 

82. MS Word এ Ctrl + D কমান্ড রকয়াগ কিকে কী আকি? 

৮২.  উত্তি: Font ডায়ােগ েক্স রিসশ থত হয়। 

83. বকান পযািাকক Left, right এেং center কিাি কী-বোডথ কমান্ড বেি? 

৮৩.  উত্তি: ব্লক কিাি পি Ctrl +L, Ctrl + R, Ctrl + E এছা়োও Justify এিজনয Ctrl + J েযেহাি কিা হয়। 

84. ‘ক্ষ’ বেিকত কী-বোডথ বর্কক ইংকিজী বকান বকান ‘কী’ চাপকত হকে? 

৮৪.  উত্তি: J + G +Shift +N 

85. MS Word কী ধিকনি িিটওয়যাি? 

৮৫.  উত্তি:এম এি ওয়াডথ একটট ওয়াডথ রকিসিং িিটওয়যাি। 

86. Row/Column Auto Fit বকন কিা হয়? 

৮৬.  উত্তি: Row/Columm এি Height এেং Width স্টযান্ডাডথ িাইজ িািািজনয Auto Fit েযেহাি কিা হয়। 

87. Word art কী? 

৮৭.  উত্তি: Word art হকো এমএি ওয়াডথ েযেহৃত একটট সেকশষ ইকিক্ট। এি মাধযকম ডকুকমকন্টিকটক্সটকক বডককাকিটটভ ককি 
বতাো যায়। 

88. সিিাইককে সেন বর্কক িাইে উোকিি ধাপগুকো বেি? 

৮৮.  উত্তি: Recycle Bin> File name select কিকত হকে, িাইে এ সিককিকত হকে, Restore এ সিক কিকত হকে। 

89. Editing Screen কী? 

৮৯.  উত্তি: এসডটটং ক্রিন হকো িীকন বটক্সট এসডট কিাি রক্রিয়া। 

90. নতুন িাইে বিাোি জনয কী কমান্ড েযেহাি কিা হয়? 

৯০.  উত্তি: Ctrl + N 

 

91. েুকাকনা Column িুোঁকজ বেি কিকত কী েযেহাি কিা হয়? 

৯১.  উত্তি: Select All Column > Home > Format > Visibility> Hides, Unhide> Unhide Columns. 

92. Title Case এ একটট োকয বেি? 

৯২.  উত্তি: A quick brown fox jumps over the lazy dog. একক্ষকত্র অর্ থাৎTitle Case এ রসতটট Word এি রর্ম অক্ষি 
capittal হকে। 

93. বকান বেিাকক ে়ে কিাি কী-বোডথ কমান্ড কী? 

৯৩.  উত্তি: Ctrl + ] 

94. বেডশীট বরাগ্রাম কী? 

৯৪.  উত্তি: বেডশীটকরাগ্রাম: বেডশীট শেটটি আসভধাসনক অর্ থ ছা়োকনা পাতা। মাইকিা কম্পিউটাকিি জনয ততিী 
বেডশীট েকে। 

95. ককয়কটট বেডশীট বরাগ্রাম নাম সেি? 

৯৫.  উত্তি: উকেিকযাগয ককয়কটট বেডশীট বরাগ্রাম হকে: ক) মাইকিািিট একক্সে ি) বোটাি-১-২-৩, গ) বকায়াকো বরা, 
 ঘ) িুপািকযাল্ক, ঙ) িিসকম,চ) মাসিিযান। 

 

96. বটসেে মাজথ কিা েেকত কী েুঝায়? 

৯৬.  উত্তি: িুকটা বটসেেকক একক্রত্রত কিাকক বটসেে মাজথ কিা েকে। 

97. ওয়াকথশীট কাকক েকে? 

৯৭.  উত্তি: িুসেশাে শীকটি বয অংকশ কাজ কিা হয় তাকক ওয়াকথশীট েকে।ওয়াকথশীট মুেত সেসভন্ন ধিকনি গাসণসতক কায থােেী 
িিািন কিা হয়। 

98. ওয়াকথেুক কাকক েকে? 

৯৮.  উত্তি: মাইকিািিট একক্সকেি বেডশীট সেসভন্ন তর্য িসন্নকেসশত তকিতা সেকিষণ ো পসিগণনা কিা হয়। কাজ কিাি পি 
ভসেষযকত েযেহাকিি জনয বকান নাকমসডস্ক িংিক্ষণ কিা যায়। িংিসক্ষত বেডশীটকক িাইে ো ওয়াকথেুক েো হয়। 

99. হসিজন্টাে িেোি কী? 

৯৯.  উত্তি: ে়ে ডকুকমন্ট সনকয় কাজ কিাি িময় পিথায় িকে বেিা একই িাকর্ বিিাযায় না। রকয়াজন অনুযায়ী দ্রতু 
ডকুকমকন্টি বয বকান জায়গায় সগকয় তা পিথায় কিািজনয পিথায় সনকচি সিকক ডাকন-োকম বয িে োি বিিা যায় তাকক 
হসিজন্টােিেোি েকে। 

100. িাংশন কী? 

১০০.  উত্তি: বকান সেকশষ সহিাে-সনকাশ িিািকনি জনয, মান সনণ থকয়ি জনযকেডশীট গুকোকত পূকে থ বর্কক সনধ থাসিত 
িমূ থোকক িাংশন েকে। 

 



১। HTTP এর পণূর্রূপ — Hyper Text Transfer 

Protocol. 

২। HTTPS এর পণূর্রূপ — Hyper Text Transfer 

Protocol Secure. 

৩। URL এর পণূর্রূপ — Uniform Resource 

Locator. 

৪। IP এর পণূর্রূপ— Internet Protocol 

৫। VIRUS এর পণূর্রূপ — Vital Information 

Resources Under 

Seize. 

৬। SIM এর পণূর্রূপ — Subscriber Identity Module. 

৭। 3G এর পণূর্রূপ — 3rd Generation. 

৮। GSM এর পণূর্রূপ — Global System for Mobile 

Communication. 

১০। CDMA এর পণূর্রূপ — Code Divison Multiple 

Access. 

১১। UMTS এর পণূর্রূপ — Universal Mobile 

Telecommunication System. 

১২। RTS এর পণূর্রূপ — Real Time Streaming 

১৩। AVI এর পণূর্রূপ — Audio Video Interleave 

১৪। SIS এর পণূর্রূপ — Symbian OS Installer File 

১৫। AMR এর পণূর্রূপ — Adaptive Multi-Rate 

Codec 

১৬। JAD এর পণূর্রূপ — Java Application 

Descriptor 

১৭। JAR এর পণূর্রূপ — Java Archive 

১৮। MP3 এর পণূর্রূপ — MPEG player lll 

১৯। 3GPP এর পণূর্রূপ — 3rd Generation 

Partnership 

Project 

২০। 3GP এর পণূর্রূপ — 3rd Generation Project 

২১। MP4 এর পণূর্রূপ — MPEG-4 video file 

২২। AAC এর পণূর্রূপ — Advanced Audio Coding 

২৩। GIF এর পণূর্রূপ — Graphic Interchangeable 

Format 

২৪। BMP এর পণূর্রূপ — Bitmap 

২৫। JPEG এর পণূর্রূপ — Joint Photographic 

Expert Group 

২৬। SWF এর পণূর্রূপ — Shock Wave Flash 

২৭। WMV এর পণূর্রূপ — Windows Media Video 

২৮। WMA এর পণূর্রূপ — Windows Media Audio 

২৯। WAV এর পণূর্রূপ — Waveform Audio 

৩০। PNG এর পণূর্রূপ — Portable Network 

Graphics 

৩১। DOC এর পণূর্রূপ — Document (Microsoft 

Corporation) 

৩২। PDF এর পণূর্রূপ — Portable Document 

Format 

৩৩। M3G এর পণূর্রূপ — Mobile 3D Graphics 

৩৪। M4A এর পণূর্রূপ — MPEG-4 Audio File 

৩৫। NTH এর পণূর্রূপ — Nokia Theme(series 40) 

৩৬। THM এর পণূর্রূপ — Themes (Sony Ericsson) 

৩৭। MMF এর পণূর্রূপ — Synthetic Music Mobile 

Application File 

৩৮। NRT এর পণূর্রূপ — Nokia Ringtone 

৩৯। XMF এর পণূর্রূপ — Extensible Music File 

৪০। WBMP এর পণূর্রূপ — Wireless Bitmap 

Image 

৪১। DVX এর পণূর্রূপ — DivX Video 

৪২। HTML এর পণূর্রূপ — Hyper Text Markup 

Language 

৪৩। WML এর পণূর্রূপ — Wireless Markup 

Language 

৪৪। CD এর পণূর্রূপ — Compact Disk. 

৪৫। DVD এর পণূর্রূপ — Digital Versatile Disk. 

৪৬। CRT — Cathode Ray Tube. 

৪৭। DAT এর পণূর্রূপ — Digital Audio Tape. 

৪৮। DOS এর পণূর্রূপ — Disk Operating System. 

৪৯। GUI এর পণূর্রূপ — Graphical User Interface. 

৫০। ISP এর পণূর্রূপ — Internet Service Provider. 

৫১। TCP এর পণূর্রূপ — Transmission Control 

Protocol. 

৫২। UPS এর পণূর্রূপ — Uninterruptible Power 

Supply. 

৫৩। HSDPA এর পণূর্রূপ — High Speed Downlink 

Packet 

Access. 

৫৪। EDGE এর পণূর্রূপ — Enhanced Data Rate 

for GSM 

[Global System for Mobile Communication] 

৫৫। VHF এর পণূর্রূপ — Very High Frequency. 

৫৬। UHF এর পণূর্রূপ — Ultra High Frequency. 

৫৭। GPRS এর পণূর্রূপ — General Packet Radio 

Service. 

৫৮। WAP এর পণূর্রূপ — Wireless Application 

Protocol. 

৫৯। ARPANET এর পণূর্রূপ — Advanced 

Research Project 

Agency Network. 

৬০। IBM এর পণূর্রূপ — International Business 

Machines. 

৬১। HP এর পণূর্রূপ — Hewlett Packard. 

৬২। AM/FM এর পণূর্রূপ — Amplitude/ Frequency 

Modulation. 

৬৩। WLAN এর পণূর্রূপ — Wireless Local Area 

Network 

৬৪। USB এর পণূর্রূপ — Universal Serial Bus. 

৬৫। HD এর পণূর্রূপ — High Definition 

৬৬। APK এর পণূর্রূপ — Android application 

package. 

৬৭। BBA এর পণূর্রূপ — Bachelor of Business 

Administration 

৬৮। SSC এর পণূর্রূপ — Secondary School 

Certificate 

৬৯। HSC এর পণূর্রূপ — Higher Secondary 

Certificate 

৭০। JSC এর পণূর্রূপ — Junior School Certificate 

জিুনয়র 

সু্কল সািটর্িফেকট। 
৭১। BCS এর পণূর্রূপ — Bangladesh Civil Service 

৭২। NCTB এর পণূর্রূপ — National Curriculam & 

Text 

Book 

৭৩। DPE এর পণূর্রূপ — Directorate of Primary 

Education 

৭৪। BA এর পণূর্রূপ — Bachelor of Arts 

৭৫। MBA এর পণূর্রূপ — Master of Business 

Administration 

৭৬। LLB এর পণূর্রূপ — Bachelor Of Law 

৭৭। MBBS এর পণূর্রূপ — BACHELOR OF 

MEDICINE AND 

BACHELOR OF SURGERY 

৭৮। VIP এর পণূর্রূপ — Very Important Person 

৭৯। PHD এর পণূর্রূপ — Doctor of Philosophy 

৮০। UNICEF এর পণূর্রূপ — United Nations 

Children’s Fund 

৮১। OK এর পণূর্রূপ — All Correct 

৮২। GMT এর পণূর্রূপ — Greenwich Mean Time 

৮৪। MA এর পণূর্রূপ — MASTER OF ARTS 

৮৫। yahoo — নরপশু 

৮৬। সফটওয়য্ার — ২ পর্কার িসেস্টম সফটওয়য্ার ও 

এিপ্লেকশন সফটওয়য্ার 

৮৭। ওয়াই ফাই এর কাজ — দর্ুতগিতর ইন্টারেনট 

৮৮। FBC এর পণূর্রূপ — Federal bureau 

corporation 

৮৯। fb এর পণূর্রূপ — Foreign body/ Facebook 

৯০। ABC এর পণূর্রূপ — Alphabetically Based 

Computerized 

৯১। বয্াকেটিরয়া েয পর্িকর্য়ায় বংশবিৃদ্ধ কের — 

Amitosesis 

৯২। DDR এর পণূর্রূপ — Double data rate 

৯৩। VAT – এর পনূর্রূপ — Value Added Tex (মলুয্ 
সংেযাজন কর) 

৯৪। IP- এর পনূর্রূপ- Internet Protocol 

৯৫। WWW এর পণূর্রূপ — World Wide Web. 

৯৬। XY এর পণূর্রূপ — Male Chromosome 

৯৭। XXY এর পণূর্রূপ — Klinefelter Syndrome 

chromosomes 

৯৮। A-Level এর পনূর্রূপ — Advanced Level 

৯৯। BL এর পনূর্রূপ — Bachelor Of Law 

১০০। LLB এর পণূর্রূপ — Bachelor Of Law 

১০১। BTV এর পনূর্রূপ — Bangladesh Television 

১০২। PIN এর পনূর্রূপ — Pin Index Number 

১০৩। PSC এর পণূর্রূপ — Primary School 

Certificate. 

১০৪। JDC- এর পণূর্রূপ — Junior Dakhil 

Certificate 

১০৫। Mbps এর পনুর্রূপ — Megabytes Per 

Second(MBps) 

১০৬। AM এর পণূর্রূপ – Ante Meridiem,অথর্ 
“িদব্পর্হেরর পেূবর্” 
১০৭। PM এর পণূর্রূপ – Post Meridiem, অথর্ 
“অপরাহ্ন” 



প্রশ্ন-১. কম্পিউটার কী? কম্পিউটার যন্ত্াাংশ গুল া ম্পক ম্পক? 
উত্তর: কম্পিউটার একম্পট ইল কট্রম্পিক্স যন্ত্। যালে পূর্ব থেলক ম্পকছু েেয থেয়া োলক, যা ইিপুট ম্পিভাইস এর 
মাধ্যলম ইিপুটকৃে গাম্পিম্পেক ও থযৌম্পিক িাটা সমূহলক প্রলসসর দ্বারা প্রম্পিয়াকৃে সুম্পিম্পেবষ্ট আউটপুট প্রোি কলর। 
কম্পিউটার সাংগঠলির অাংশগুল া ম্পিুরূপ 
র. ইিপুট ইউম্পিট: থয ইউম্পিলটর মাধ্যলম কম্পিউটারলক যার্েীয় েেয র্া উপাত্ত প্রোি করা হয়, োলক ইিপুট 
ইউম্পিট র্ল । থযমি- 
* কীলর্ািব; 
* মাউস; 
* স্ক্যািার; 
* জয়ম্পিক; 
*  াইটলপি; 
* ম্পিম্পজটা  কযালমরা; 
* পাঞ্চকািব ম্পরিার; 
* অপম্পটকা  মাকব ম্পরিার; 
* অপম্পটকা  কযালরকটার ম্পরিার এর্াং 
* থপপার থটপ ম্পরিার। 
 
থমমম্পর ইউম্পিট: থয ইউম্পিলট েেয সাংরক্ষি করা যায় এর্াং প্রলয়াজলি উলত্তা ি করা যায়, োলক থমমম্পর ইউম্পিট 
র্ল । থযমি- 
* হািবম্পিস্ক্; 
* ফ্লম্পপ ম্পিস্ক্ ম্পসম্পি; 
* ম্পিম্পভম্পি এর্াং 
* ফ্লযাশ ড্রাইভ। 
 
গাম্পিম্পেক ও থযৌম্পিক ইউম্পিট: গাম্পিম্পেক ও থযৌম্পিক ইউম্পিট যার্েীয় ম্পহসার্ থযমি: থযাগ, ম্পর্লয়াগ, গুি, ভাগ 
ইেযাম্পে কাযব সিন্ন কলর। 
রা. ম্পিয়ন্ত্ি ইউম্পিট: এই অাংশ কম্পিউটালরর যার্েীয় কাযবার্ম্প  ম্পিয়ন্ত্ি কলর। 
আউটপুট ইউম্পিট: থয ইউম্পিলটর মাধ্যলম কম্পিউটার যার্েীয় ফ াফ  প্রোি কলর, োলক আউটপুট ইউম্পিট 
র্ল । 
থযমি- 
* মম্পিটর; 
* ম্পপ্রন্টার; 
* ম্পভজুযয়া  ম্পিসলে; 
* ম্পফল্ম থরকিবার; 
* ¯ পীকার এর্াং 
* মাইলিালফাি। 
 
প্রশ্ন-২. কম্পিউটালরর কাজ ম্প খ। 
উত্তর: কম্পিউটার ম্পিম্নম্প ম্পখে ৪ম্পট গুরুত্বপূিব কাজ কলর। যো- 
* সমসযা সমাধ্ালির উলেলশয র্যর্হারকারী কেৃবক তেম্পর থপ্রাগ্রাম কম্পিউটার গ্রহি কলর থমমম্পরলে সাংরক্ষি কলর 
এর্াং 
র্যর্হারকারীর ম্পিলেবলশ কম্পিউটার থপ্রাগ্রাম ম্পির্বাহ কলর; 
* ইিপুট ম্পিভাইস-এর মাধ্যলম িাটা গ্রহি কলর; 
* থিটা প্রলসস কলর এর্াং 
* আউটপুট ম্পিভাইস-এর মাধ্যলম ফ াফ  প্রকাশ কলর। 
 
প্রশ্ন-৩. ম্পসম্পপউ থক কম্পিউটালরর মম্পিস্ক্ র্ া হয় থক? 
উত্তর: কম্পিউটালরর সাাংগঠম্পিক অাংশগুল ার মলধ্য ম্পসম্পপউ (থসন্ট্রা  প্রলসম্পসাং ইউম্পিট) সর্লেলয় গুরুত্বপূিব। 
কম্পিউটালর কাজ করার সময় আমরা থয সর্ ম্পিলেবশ ম্পেলয় োম্পক থসগুল ার গাম্পিম্পেক ম্পর্লেষি, যুম্পিমূ ক 
ম্পর্িযাস, ম্পিয়ন্ত্ি এর্াং ম্পিম্পেবষ্ট সমলয়র জিয প্রলয়াজিীয় েেয সাংরক্ষি; এক কোয় যার্েীয় প্রম্পিয়াকরলির কাজ 
এই অাংলশ হলয় োলক। প্রাম্পির মম্পিস্ক্ থযমি যার্েীয় কাজ ম্পিয়ন্ত্লির মাধ্যলম থেহলক সে  রালখ, কম্পিউটার 
ম্পসম্পপউ থেমম্পি যার্েীয় কমবসিােলির মাধ্যলম কম্পিউটারলক কাযবউপলযাগী রালখ। এজিয ম্পসম্পপউলক 
কম্পিউটালরর মম্পিস্ক্ র্ া হয়। 
 
প্রশ্ন-৪. কম্পিউটালরর কলয়কম্পট গুরুত্বপূিব তর্ম্পশষ্টয ম্প খ। 
উত্তর: ম্পিভুব ো, দ্রুেগম্পে, সুক্ষো, যুম্পিসাংগে ম্পসদ্ধান্ত, র্হুমূখীো, থমমম্পর, স্বয়াংম্পিয়ো এর্াং সহিশী ো। 
 
প্রশ্ন-৫. কম্পিউটালরর থমৌম্প ক সীমার্দ্ধো কী ? কম্পিউটালরর ম্পক ম্পেন্তা শম্পি আলছ? 
উত্তর: কম্পিউটার একম্পট যন্ত্ মাত্র। এর ম্পেন্তা শম্পি থিই, থিই র্ুম্পদ্ধমত্তা র্া ম্পর্োর ম্পর্লেষি এর্াং ম্পর্লর্েিার 
মাধ্যলম ম্পসদ্ধান্ত গ্রহলির ক্ষমো। 
প্রশ্ন-৬. ম্পর্ম্পভন্ন প্রজলের কম্পিউটালরর তর্ম্পশষ্টয সমূহ ম্প খ। 
উত্তর: প্রেম প্রজে (১৯৫১-১৯৫৯) 
* আকালর র্ড় ম্পর্ধ্ায় প্রেুর োপ উৎপােিকারী; 
* থমমম্পর অেযন্ত অল্প; 
* ভযাকুয়াম ম্পটউর্ ম্পেলয় তেম্পর; 
* থমমম্পর থেৌম্বকীয় ড্রালমর; 
* থকাি র্যর্হার কলর থপ্রাগ্রাম ো ালিার র্যর্স্থা; 
* এই কম্পিউটালরর যাম্পন্ত্ক থগা লযাগ, রক্ষিালর্ক্ষি ও পাওয়ার খরে থর্ম্পশ এর্াং 
* এই প্রজলের কম্পিউটালর যাম্পন্ত্ক ভাষায় থপ্রাগ্রাম ম্প খা হে। 
 

ম্পদ্বেীয় প্রজে (১৯৫৯-১৯৬৫) 
* এম্পটলে মম্পিউ  ম্পিজাইি র্যর্হার কলর সাম্পকবলটর প্রধ্াি প্রধ্াি অাংশগুল া আ াো থর্ালিব তেম্পর করা থযে; 
* অম্পধ্ক ম্পিভবরশী , অম্পধ্ক ধ্ারিক্ষমো এর্াং েেয স্থািান্তলরর সুম্পর্ধ্া; 
* সাইলজ থছাট, গম্পে থর্ম্পশ এর্াং ম্পর্দ্যযৎ ও োপ উৎপােি কম; 
* ট্রািম্পজির দ্বারা তেম্পর ও থমমম্পর েুম্বক থকালরর এর্াং 
* অযালসম্বম্প  ভাষায় থপ্রাগ্রাম ম্প খা হে। 
 
েৃেীয় প্রজে (১৯৬৫-১৯৭১) 
* ম্পর্ম্পভন্ন প্রকার উন্নে থমমম্পর র্যর্স্থার উদ্ভার্ি; 
* র্যাপক একীভূে র্েবিীর র্যর্হার; 
* সাইজ থছাট র্ল  ম্পর্দ্যযৎ খরে কম এর্াং 
* উচ্চ ভাষা ম্পেলয় থপ্রাগ্রাম ম্প খা েৃেীয় প্রজলের কম্পিউটার থেলক শুরু হয়। 
 
েেুেব প্রজে (১৯৭১- র্েবমাি) 
* উন্নে ম্পেপ এর র্যর্হার ও ক্ষুদ্রাকৃম্পের কম্পিউটার; 
* ম্পর্শা  পম্পরমাি থমমম্পর ও অেযন্ত গম্পে এর্াং 
* থটম্প লযাগালযাগ  াইি র্যর্হার কলর িাটা আোি-প্রোি। 
 
পঞ্চম প্রজে (ভম্পর্ষযৎ প্রজে) 
* এই ধ্রলির কম্পিউটার প্রম্পে থসলকলে ১০-১৫ থকাম্পট থযৌম্পিক ম্পসদ্ধান্ত ম্পিলে পারলর্। 
* শলের মাধ্যলম থযাগালযাগ করা যালর্। ফল  এই প্রজলের কম্পিউটার শুিলে পারলর্ এর্াং কো র্ লে পারলর্। 
* এই প্রজলের কম্পিউটালরর কৃম্পত্রম র্ুম্পদ্ধমত্তা োকলর্। ফল  কম্পিউটার অম্পভজ্ঞো সঞ্চয় কলর ো ম্পসদ্ধান্ত গ্রহলি 
র্যর্হার করলে পারলর্। 
* ম্পভজুয়যা  ইিপুট র্া ছম্পর্ থেলক িাটা গ্রহি করলে পারলর্। 
 

প্রশ্ন-৭. অযার্াকাস ম্পক? 
উত্তর: অযার্াকাস হলে আড়াআম্পড় োলর থছাট্ট থগা ক র্া পুুঁম্পে  াগালিা োরলকািা কালঠর একম্পট কাঠালমা। 
এখিকার কম্পিউটালরর মে অযার্াকাসও সাংখযালক সাংলকে র্া থকাি ম্পহলসলর্ ম্পর্লর্েিা কলর- কাঠালমালে 
োলরর অর্স্থাি ও োলর পুুঁম্পের উপম্পস্থম্পে সাংলকে ম্পিরূপি কলর। ম্পিিপূর্ব ৩০০০ সাল  র্যাম্পর্ লি এম্পট আম্পর্স্ক্ার 
হয় র্ল  ধ্ারিা করা হয়। অযার্াকাস ম্পেলয় সাধ্ারিে থযাগ, ম্পর্লয়াগ, গুি, ভাগ, র্গব ও র্গবমূ  ম্পিরূপি করা 
থযে। 
 
প্রশ্ন-৮. অযািাম্প ম্পটকযা  ইম্পিি কী? 
উত্তর: ো বস র্যালর্জ ১৮৩৪ সাল  থযলকাি প্রকার ম্পহসার্কালযব সক্ষম এরূপ একম্পট ম্পহসার্ যলন্ত্র পম্পরকল্পিা 
শুরু কলরি। যালে থপ্রাগ্রাম ম্পির্বাহ ও পাঞ্চকালিব ম্পহসার্কালযবর ম্পিলেবশসমূহলক সাংরক্ষলির পম্পরকল্পিা ম্পছ । এই 
যন্ত্ম্পট অযািাম্প ম্পটকযা  
ইম্পিি িালম পম্পরম্পেে। 
 
প্রশ্ন-৯. ো বস র্যালর্জ থক? থকি োলক কম্পিউটালরর জিক র্ া হয়? 
উত্তর: ো বস র্যালর্জ থকমম্পিজ ম্পর্শ্বম্পর্েযা লয়র গম্পিলের অধ্যাপক। ম্পেম্পি ১৮৩৪ সাল  আধ্ুম্পিক কম্পিউটালরর 
মে ম্পিয়ন্ত্ি অাংশ, গাম্পিম্পেক ও থযৌম্পিক অাংশ, সৃ্মম্পে অাংশ এর্াং অিযািয তর্ম্পশষ্টয সম্বম্প ে অযািাম্প ম্পটকযা  ইম্পিি 
িালম একম্পট থমকাম্পিকযা  কম্পিউটালরর পম্পরকল্পিা কলরম্পছল ি। ো বস র্যালর্লজর এই যন্ত্ম্পট আধ্ুম্পিক 
কম্পিউটালরর পূর্বসূম্পর হলয় 
আলছ র্ল  ো বস র্যালর্জলক কম্পিউটালরর জিক র্ া হয়। 
 
প্রশ্ন-১০. কালক প্রেম কম্পিউটার থপ্রাগ্রামার ম্পহলসলর্ ম্পর্লর্েিা করা হয় এর্াং থকি? 
উত্তর: ইাংলরজ কম্পর্  ি র্ায়রলির কিযা অযািা অগািালক প্রেম কম্পিউটার থপ্রাগ্রামার ম্পহলসলর্ ম্পর্লর্েিা করা 
হয় । কারি ম্পেম্পিই আধ্ুম্পিক কম্পিউটালরর পূর্বসূম্পর অযািাম্প ম্পটকযা  ইম্পিি-এর জিয থপ্রাগ্রাম রেিা কলরি। 
 
প্রশ্ন-১১. থমমম্পরলে রম্পক্ষে থপ্রাগ্রাম ম্পির্বালহর ধ্ারিা থক প্রোি কলরি? 
উত্তর: ১৯৪৫ সাল  প্রখযাে গম্পিেম্পর্ে জি ভি ম্পিউমযাি সর্বপ্রেম থমমম্পরলে রম্পক্ষে থপ্রাগ্রাম ম্পির্বালহর ধ্ারিা 
প্রোি কলরি। 
 
প্রশ্ন-১২. কম্পিউটার আম্পর্স্ক্ার কলরি থক ? থকি োলক কম্পিউটালরর আম্পর্স্ক্ারক র্ া হয়? 
উত্তর: কম্পিউটার আম্পর্স্ক্ার কলরি হাওয়ািব এইে এম্পকি। যুিরালের হাভবািব ম্পর্শ্বম্পর্েযা য় ও আইম্পর্এম এর 
থযৌে উলেযালগ এর্াং হাওয়ািব এইে এম্পকি-এর েত্ত্বার্ধ্ালি ১৯৪৩ সাল  মাকব-১ িালম একম্পট পূিবাঙ্গ ম্পিম্পজটা  
কম্পিউটার ম্পিম্পমবে হয়। এজিয হাওয়ািব এইে এম্পকি থক কম্পিউটালরর আম্পর্স্ক্ারক র্ া হয়। 
 
প্রশ্ন-১৩. কলর্ এর্াং কারা ট্রািম্পজির তেম্পর কলরি? 
উত্তর: ১৯৪৮ সাল  আলমম্পরকার থর্   যার্লরটম্পরলে উইম্প য়াম শকল , জি র্াম্পিবি এর্াং এইে ম্পিলটি 
সম্পিম্প েভালর্ ট্রািম্পজির তেম্পর কলরি। 
 
প্রশ্ন-১৪. আই.ম্পস (ইম্পন্টলগ্রলটি সাম্পকবট) তেম্পর কলরি কারা? 
উত্তর: থটক্সাস ইন্সট্রুলমন্ট- এর জযাক ম্পক ম্পর্ ও থফয়ারোইল্ড- এর রর্াটব িলয়স ১৯৫৮ সাল  আইম্পস তেম্পর 
কলরি। 
 
প্রশ্ন-১৫. থক এর্াং কলর্ মাইলিাপ্রলসসর তেম্পর কলরি? 
উত্তর: ি. থটি হফ ১৯৭১ সাল  (প্রেম মাইলিাপ্রলসসর ইলন্ট - ৪০০৪) মাইলিাপ্রলসসর তেম্পর কলরি। 
 
প্রশ্ন-১৬. মাইলিাকম্পিউটালরর জিক থক? থকি োলক মাইলিাকম্পিউটালরর জিক র্ া হয়? 



উত্তর: েম্পড়ৎ প্রলকৌশ ী এইে এিওয়ািব রর্াটবসলক মাইলিাকম্পিউটালরর জিক র্ া হয়। ম্পেম্পি ১৯৭৫ সাল  
অ লটয়ার-৮৮০ িালম প্রেম মাইলিাকম্পিউটার তেম্পর কলরি। এজিয েম্পড়ৎ প্রলকৌশ ী এইে এিওয়ািব 
রর্াটবসলক মাইলিাকম্পিউটালরর জিক র্ া হয়। 
 
প্রশ্ন-১৮. আই.ম্পর্.এম (ইন্টারিযাশিা  ম্পর্জলিস থমম্পসি) ম্পপম্পস তেম্পর হয় কলর্? 
উত্তর: ১৯৮১ সাল র ১২ আগি থেলক থর্র হয় পালসবািা  কম্পিউটার। 
 
প্রশ্ন-১৯. মাইলিাসফ্ট কলর্ এর্াং কারা প্রম্পেষ্ঠা কলরি? 
উত্তর: ১৯৭৫ সাল র থফি“য়াম্পর মালস হাভবািব ম্পর্শ্বম্পর্েযা য়- এর ছাত্র ম্পর্  থগটস ও োর ঘম্পিষ্ঠ র্নু্ধ ওয়াম্পশাংটি 
থিি ম্পর্শ্বম্পর্েযা লয়র প  অযাল ি মযাসােুলসটস ইন্সম্পটম্পটউট অর্ থটকলিা ম্পজ-এর জিয থর্ম্পসক থপ্রাগ্রাম ম্প লখি। 
প  অযাল ি ম্পর্শ্বম্পর্েযা য় থশষ কলর মযাসেুলিস ইন্সম্পটম্পটউট অর্ থটকলিা ম্পজলে থযাগোি করল ও ম্পর্  থগটস 
সিূিবভালর্ কম্পিউটার জগলে প্রলর্শ কলরি এর্াং ১৯৭৭ সাল  মাইলিাসফ্ট কলপবালরশি প্রম্পেষ্ঠা কলরি। 
 
প্রশ্ন-২০. কলর্ এর্াং কারা অযাপ  থকািাম্পি প্রম্পেষ্ঠা কলরি? 
উত্তর: ১৯৭৬ সাল  ম্পিভ জর্স ও ম্পিলফি উযম্পিয়াক ম্পমল  অযাপ -১ কম্পিউটার তেম্পর কলরি। এর পরর্েবী 
র্ছরই োরা অযাপ  কম্পিউটার থকািাম্পি প্রম্পেষ্ঠা কলরি। 
 
প্রশ্ন-২১. ইন্টারলিলটর জিক থক? 
উত্তর: ইন্টারলিলটর জিক ম্পভন্টি ম্পজ কাফব 
 
প্রশ্ন-২৩. ই-থমই  (ইল কট্রম্পিক থমই ) এর প্রর্েবি কলরি থক? 
উত্তর: ১৯৭১ সাল  থর টমম্প িসি ই-থমই  এর প্রর্েবি কলরি। 
 
প্রশ্ন-২৪.জিম্পপ্রয় সােব ইম্পিি গুগল র প্রম্পেষ্ঠাো কারা? 
উত্তর: ১৯৯৪ সাল  সালগবই ম্পিি ও  যাম্পর থপজ জিম্পপ্রয় সােব ইম্পিি গুগ  প্রম্পেষ্ঠা কলরি। 
 
প্রশ্ন-২৫. জিম্পপ্রয় সামাম্পজক থযাগালযালগর সাইট থফইসর্ুক- এর প্রম্পেষ্ঠাো থক? 
উত্তর: জিম্পপ্রয় সামাম্পজক থযাগালযালগর সাইট থফইসর্ুক- এর প্রম্পেষ্ঠা কলরি মাকব জুকারর্াগ 
 
প্রশ্ন-২৬. সফ্টওয়যার ম্পক ও কে প্রকার? 
উত্তর: থকাি সমসযা সমাধ্ালির জিয ধ্ারার্াম্পহক ম্পিলেবশার্ম্প র সমম্পষ্টলক সফ্টওয়যার র্ল । 
সফ্টওয়যার প্রধ্ািে দ্যই প্রকার: 
* ম্পসলিম সফ্টওয়যার (থযমি: অপালরম্পটাং ম্পসলিম) এর্াং 
* অযাম্পেলকশি সফ্টওয়যার (থযমি: মাইলিাসফ্ট ওয়ািব)। 
 
প্রশ্ন-২৭. ফামবওয়যার ম্পক ? 
উত্তর: কম্পিউটারলক প্রােম্পমকভালর্ পম্পরো িার জিয রম-এ স্থায়ীভালর্ ম্পকছু েেয জমা োলক, এই েেযগুল ালক 
ফামবওয়যার র্ল । 
 
প্রশ্ন-২৮. অপালরম্পটাং ম্পসলিম কী? 
উত্তর: কম্পিউটালরর ম্পিলজর ম্পিয়ন্ত্লির জিয থয থপ্রাগ্রাম র্যর্হৃে হয় োলক অপালরম্পটাং ম্পসলিম র্ল । 
থযমি- উইলোজ এক্সম্পপ, উইলোজ ম্পভিা এর্াং ম্প িাক্স। 
 
প্রশ্ন-২৯. মাম্পিম্পমম্পিয়া কালক র্ল ? 
উত্তর: থকাি ম্পর্ষয়লক উপস্থাপলির জিয থটক্সট, অযাম্পিলমশি, অম্পিও এর্াং ম্পভম্পিও এর সমম্পিে রূপলক 
মাম্পিম্পমম্পিয়া র্ল । 
 
প্রশ্ন-৩০. কম্পিউটার থিটওয়াকব কালক র্ল ? 
উত্তর: িাটা র্া ম্পরলসাসব থশয়ার করার উলেলশয দ্যই র্া েলোম্পধ্ক কম্পিউটালরর সাংযুম্পিলক কম্পিউটার 
থিটওয়াকব র্ল । 
 
প্রশ্ন-৩১. ইন্টারলিট কী? 
উত্তর: দ্যই র্া েলোম্পধ্ক ম্পভন্ন িযাোিব-এর থিটওয়াকবলক মধ্যর্েবী ম্পসলিম (থযমি: থগটওলয়, রাউটার)-এর 
মাধ্যলম 
আন্ত-সাংযুবি কলর থয ম্পমশ্র প্রকৃম্পের থিটওয়ালকবর ম্পিজাইি করা হয়, োলক ইন্টারলিট র্ল । 
 
প্রশ্ন-৩২. ই-থমই  কী? 
উত্তর: ইল কট্রম্পিক থমই  এর সাংম্পক্ষপ্ত রূপ ই-থমই । ই-থমই  এর সাহালযয ইন্টারলিট র্যর্হার কলর 
দ্রুেগম্পেলে েেয আোি-প্রোি করা যায়। থযখালি সাধ্ারি িাকলযালগ ম্পেম্পঠ থপ্ররলি কলয়কম্পেি সময়  ালগ; 
থসখালি ই-থমই  এর সাহালযয কলয়ক থসলকলের মলধ্য পৃম্পের্ীর থযলকাি প্রালন্ত েেয আোি-প্রোি করা যায়। 
 
প্রশ্ন-৩৩. র্াাং ালেলশ কে সাল  এর্াং থকাোয় প্রেম কম্পিউটার র্যর্হৃে হয়? 
উ: ১৯৬৪ সাল  র্াাং ালেশ পরমািু শম্পি গলর্ষিা থকলে। 
 
প্রশ্ন-৩৪. র্াাং ালেলশ অি াইি ইন্টারলিট থসর্া কলর্ ো ু হয়? 
উত্তর: র্াাং ালেলশ অি াইি ইন্টারলিট থসর্া ো ু হয় ১৯৯৬ সাল র ৪ জুি। 
 
প্রশ্ন-৩৫. কম্পিউটার ভাইরাস কী? 

উত্তর: V I R U S  এর পূিবিাম V i t a l  I n f o r ma t i o n  R e s o u r c e  
U n d e r  S e i z e  । কম্পিউটার ভাইরাস হলে এক ধ্রলির অম্পিষ্টকারী থপ্রাগ্রাম। ইহা কম্পিউটালরর 
স্বাভাম্পর্ক থপ্রাগ্রামগুল ার কালজ ম্পর্ঘœ ঘটায়। ১৯৮৮ সাল  ফ্রাইি থকালহি কম্পিউটার ভাইরাস শিাি কলরি। 
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mKj cÖ‡kœi DËi w`‡Z n‡e| (gvb 1  50 = 50) mwVK DËiwU‡Z wUK (√) wPý `vI t 
1| Qwe, †U·U, MÖvd BZ¨vw`i †ÿ‡Î †Kvb Object wU 

e¨eüZ nq ? 
(K) Hyperlink  (L) Text 

(M) Display Text  (N) OLE  
2|  D11 n‡Z D20 †m‡ji WvUv †hvM Kivi dvskb Ñ 

(K) =Sum (D11+D20) 

(L) =Sum (D11; D20) 

(M) =Sum (D11:D20)  
(N) = Sum (D11,D20) 

3|   Sort Gi Formula _v‡K †Kvb †gby‡Z? 
(K) Window    (L) Insert 

(M) Tools     (N) Table  
4|   †KvbwU Storage Device? 

(K) Keyboard    (L) Scanner 

(M) Hard disk     (N) Mouse 
5|  GKwU wd‡ìi bvg †jL‡Z m‡ev©”P KqwU K¨v‡i±vi 

e¨envi Kiv nq? 
(K) 40 wU     (L) 33 wU 

(M) 21 wU     (N) 64 wU  
6|  Line spacing †`o¸b Kivi KgvÛÑ 

(K) Ctrl+1    (L) Ctrl+2 

(M) Ctrl+5     (N) Ctrl+1.5 

Note: Line spacing †`o¸b Kivi Keyboard KgvÛ Ñ 
Ctrl+5  

7|  Excel-G GKvwaK Cell GKwÎZ Kiv‡K Kx e‡j? 
(K) Add     (L) Join 

(M) Merge     (N) Union 
8|  File close-Gi Kx-†evW© KgvÛ †KvbwU? 

(K) Ctrl+ O (L) Ctrl +W  

(M) Alt+ O (N) Ctrl+F4  
9|  cÖvBgvwi ÔKxÕ n‡”QÑ  

(K) †h GwUªweD‡Ui cÖwZwU gvb Awfbœ nq 
(L) †h GwUªweD‡Ui cÖwZwU gvb wfbœ wfbœ nq  

(M) †h GwUªweD‡Ui gvb _v‡K bv  
(N) †h GwUªweD‡Ui GKvwaK gvb aviY K‡i  

10|  ICT- Gi c~Y©iƒc Kx? 
(K) Information Communication & 

Technology 
(L) Information & Communication 

Technology  
(M) Information Computer Technology 

(N) International Commercial Trading 
 mwVK kã w`‡q k~Y¨ ’̄vb c~iY Ki t 
11|  Computer-Gi cÖ_g †cÖvMÖvg iPwqZvi bvg...| 

DËi t †jwW G¨vWv AMv÷v 
12|  Legal KvM‡Ri mvBR nj...................| 
 DËi t cÖ ’̄ 8.5" Ges ‰`N©¨ 14" 
13|  Double Underline Kivi mswÿß KgvÛ...........| 
 DËi t Ctrl+Shift+D 

14|  MS Power Point GKwU............ md&UIq v̈i| 
 DËi t Presentation  
15|  Spelling and Grammar-Gi Rb¨........ 
 dvskb ÔKxÕ Pvc‡Z nq| 
 DËi t F7 
16|  OMR- Gi c~Y©iƒc nj.......................| 
 DËi t Optical Mark Reader 
17|  CPU-n‡”Q...............................| 
 DËi t Central Processing Unit 
18|  Redo-Gi Keyboard KgvÛ nj...........| 
 DËi t Ctrl+Y 
19|  mvaviYZ wPwVcÎ †jLvi Rb¨................. †cÖvMÖvg e¨eüZ 

nq| 
 DËit MS-Word 
20|  ø̄vBW †kv Gi Rb¨ .................. dvskb ÔKxÕ Pvc‡Z nq| 
 DËit F5 

 

 evK¨wU mZ¨ n‡j ÔmÕ wg_¨v n‡j ÔwgÕ †jL t 



evKvwk‡ev cÖkœvejx 

 2 

21|   MSÑExcelÑ G 16777216 wU †mj Av‡Q 
 DËi t ÔmÕ 
22|  Data Sort ỳB cÖKvi|  DËi t ÔmÕ 
23|  Back space key †P‡c Wvb cv‡ki †jLv‡K gyQv hvq|  
 DËi t ÔwgÕ 
24|  Keyboard - Gi †gvU ̀ ywU Alt-key Av‡Q| 
 DËi t ÔmÕ 
25|  Scanner GKwU Output device  
 DËi t ÔwgÕ 
26|  Funtion key †gvU 10 wU|  DËi t ÔwgÕ 
  
27|  MS-Excel-G †h †Kvb dvsk‡bi ïiæ‡Z IF e¨envi Kiv nq| 

  DËi t ÔwgÕ 
28|  Facebook GKwU B›Uvi‡bU eªvDwRs mdUIq v̈i|   
 DËi t ÔwgÕ 
29|  (11)10 msL¨vwU‡K evBbvix †Z cÖKvk Ki‡j (1011)2 n‡e| 

  DËi t ÔmÕ 
30|  Kw¤úDUv‡ii Recycle Bin n‡Z gy‡Q †djv WvUv cybivq wdwi‡q 

Avbv hvq bv|  
 DËi t ÔmZ¨Õ  
 
 AwZ ms‡ÿ‡c DËi `vI t 
31|  Application Software Kx?   

DËi t †h Software e¨enviKvixi e¨envwiK Kv‡Ri 
wbwg‡Ë¡ evwYwR¨K wfwË‡Z ˆZwi Kiv nq, Zv‡K 
Application Software e‡j| 

32|  Kq BitÑ G 1 Byte?   
 DËi t 8 (Eight) Bit-G 1 Byte nq| 
33| BTEBÑGi c~Y©iƒc Kx? 
 DËit Bangladesh Technical Education Board 
34|  MS WordÑG Ctrl+D KgvÛ cÖ‡qvM Ki‡j Kx Av‡m? 
 DËi t Font WvqvjM e· cÖ`wk©Z nq| 
35| Column break Kivi Rb¨ ÔKx-†evW©Õ KgvÛ †_‡K cÖ`Ë 

KgvÛwU †jL| 
 DËi t Format †gby †_‡K Columns G Click K‡i 3 

Column wewkó GKwU Kjvg ˆZwii ci 
Ctrl+Shift+Enter. 

36|  †Kv‡bv c¨viv‡K Left, Right, Ges Center Kivi ÔKx- 
†evW©Õ KgvÛ †jL|  

 DËi t  eøK Kivi ci Left = Ctrl+L,  

 Right = Ctrl+R, Center = Ctrl+E  

37|  MS ExcelÑG F2 key Kx Kv‡R e¨envi Kiv nq? 
 DËi t †Kvb Cell Gi WvUv‡K Edit Kivi Rb¨ †m‡ji 

Af¨šÍ‡i Cursor ¯’vc‡bi †ÿ‡Î| 
38| wi‡jwUf I A¨vemy‡jU †mj A¨v‡Wª‡mi GKwU K‡i D`vniY 

`vI| 
 DËi t Column Ges Row Gi mgš̂‡q mivmwi †h †mj 

A¨v‡Wªm e¨envi Kiv nq †hgb- B Kjv‡gi 3bs Row Gi 
Rb¨ B3, D Kjv‡gi 5 bs Row Gi Rb¨ D5 BZ¨vw`; 
G‡K wi‡jwUf †mj A¨v‡Wªm e‡j| $ wPý e¨envi K‡i †h 
†mj A¨v‡Wªm wjLv nq †hgb- $A1:$A5 Zv‡K A¨vem y‡jU 
†mj A¨v‡Wªm e‡j| 

39|  Title case-G GKwU evK¨ wjL| 
 DËi t A Quick Brown Fox Jumps Over The 

Lazy Dog. G‡ÿ‡Î Title case G cÖwZwU Word Gi 
cÖ_g Aÿi Capital n‡e| 

40|  evsjv‡`k KvwiMwi wkÿv †evW© †Kvb mv‡j cÖwZwôZ nq Ges 
†Kvb †Rjvq Aew ’̄Z? 

 DËi t 1954 mv‡j 1bs msm`xq AvBb e‡j GwU cÖwZwôZ 
nq| GwU XvKv †Rjvq Aew¯’Z| 

 Translate in to English t 
41|  †m ¯‹z‡j hvq| 
 DËi t He goes to school. 
42|  Avgv‡K GKwU Kgjv `vI| 
 DËi t Give me an Orange. 
43|  Zzwg †Kgb Av‡Qv? 
 DËi t How are you? 

 Fill in the blanks t 
44. He is…..... honest man.   Ans. an 
45. The earth…….. round.   Ans. is 
46. I want to…. a letter.   Ans. write 
47. My mother reads…… holy Quran. 
 Ans. the. 

 Answer the following question t 
48.  How old are you4? 
 Ans. I am 14 years old. 
49.  How many brothers do you have? 
 Ans. I have one brother. 
50.  Who is your best friend? 
 Ans. Hossain is my best friend 
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 mwVK DËiwU‡Z wUK (√) wPý `vIt 
1| wb‡Pi †KvbwU CPUÑGi Ask bq ? 

(K) ALU (L) MU 

(M) ROM  (N) CU 
2|  RAM GKwUÑ 

(K) †m‡KÛvwi †g‡gvwi (L) ¯’vqx †g‡gvwi 
(M) A¯’vqx †g‡gvwi  (N) d¬vk †g‡gvwi 

3|   Copy-Gi Kx-†evW© KgvÛ †KvbwU ? 
(K) Ctrl+C  (L) Ctrl+P 
(M) Ctrl+X (N) Ctrl+K 

4|  Undo Gi KxÑ†evW© KgvÛ †KvbwU ? 
(K) Ctrl+Z  (L) Ctrl+V 
(M) Ctrl+C (N) Ctrl+P 

5|  †KvbwU Database †cÖvMÖvg ? 
(K) Word Perfect (L) MS-Excel 
(M) MS-Word (N) MS-Access 

6|  MS-WordÑG evbvb ï× Kivi Rb¨ e¨eüZ nqÑ 
(K) Spell checker   (L) Thesaurus 
(M) Edit  (N) Grammar 

7|  Print Preview †Kvb MenuÑGi †fZi _v‡K ? 
(K) File  (L) Edit 
(M) View (N) Grammar 

8|  Mail merge _v‡KÑ 
(K) Table-G (L) Format-G 
(M) Tools-G  (N) Window-G 

9|  (111001)2-Gi Hexa-Decimal-G cÖKvk 
(K) E1 (L) 39  
(M) 3B (N) 93 

10|  evsjv‡`‡k †Kvb mv‡j cÖ_g Kw¤úDUvi Av‡m ? 
(K) 1944  (L) 1964  
(M) 1951  (N) 1971 
 

 evK¨wU mZ¨ n‡j ÒmÓ wg_¨v n‡j ÒwgÓ †jL t 

11|  Kw¤úDUv‡ii cÖwµqvKiY Ask n‡”Q gv`vi‡evW©| 
DËi t wg_¨v 

12|  MS-Excel n‡”Q GKwU Spread sheet    

       analysis program| 
DËi t mZ¨ 

13| (1001)2 msL¨v‡K `kwg‡K cÖKvk Ki‡j 11nq| 
DËi t  wg_¨v 

14|  Computer-Gi Virus GKwU RxevYy| 
DËi t wg_¨v 

15|  Folder-Gi wfZi File I Folder DfqB _vK‡Z cv‡i| 
DËi t mZ¨ 

16|  MS word n‡jv IqvW© cÖ‡mwms c¨v‡KR| 
DËi t mZ¨ 

17|  Hard Disk GKwU Processing wWfvBm| 
DËi t wg_¨v 

18|  B¼‡RU wcÖ›Uvi GKwU bb&-B¤ú¨v± wcÖ›Uvi| 
DËi t wg_¨v 

19|  Windows 7 GKwU Application software| 
DËi t wg_¨v 

20|  Pen drive †K d¬vk †g‡gvwi ejv nq| 
DËi t mZ¨ 

 
 mwVK kã w`‡q k~b¨ ’̄vb c~iY Kit 
21|  ¯‹¨vbvi GKwU ................ wWfvBm| 

DËi t Input| 

22|  bv¤^vi wm‡÷g ................. cÖKvi| 
DËi t 4 

23|  GK wMMvevBU  .......... †gMvevBU| 
DËi t 1024| 

24|  Legal size KvM‡Ri cwigvc n‡”Q ..........| 
 DËi t cÖ¯’ 8.5" Ges ‰`N ©̈ 14" 

25|  (13)10 msL v̈wU evBbvwi‡Z iæcvšÍi Ki‡j ........... n‡e| 
DËi t (1101)2 

26|  GKB wPwV wewfbœ wVKvbvq †cÖi‡Yi Rb .̈........ e¨eüZ nq| 
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DËi t Mail Merge  
27|  WWW-Gi c~Y©bvg .......... | 

DËi t World Wide Web 

28|  Microsoft Power Point GKwU ..........| 
DËi t Presentation Software 

29|  Recycle Bin †dvìv‡i .......... dvBj Rgv _v‡K| 
DËi t Delete Kiv 

30|  wm.wW ig GKwU.......... wWfvBm| 
DËi t Input 

 
 AwZ ms‡ÿ‡c DËi `vI t 
31|  Bit Kx ? 
 DËi t evBbvix bv¤^vi c×wZ‡Z e¨eüZ AsK 0 (ïb¨) 

Ges 1 (GK) †K weU e‡j|   
32|  Operating system ej‡Z Kx †evSvq ? 

DËi t Kw¤úDUvi cwiPvjbvi c×wZ‡K Operating 

system ejv nq|  
33|  OMR Kx ? 

DËi t OMR n‡”Q Optical Mark Reader 
34|  Gg. Gm. G‡·j Kx ? 

DËi t Gg. Gm. G‡·j GKwU Spread Sheet Analysis 

Package program   
35|  PviwU Input DeviceÑGi bvg †jL t 

DËi t Kx- †evW©, gvDm, gvB‡µv‡dvb, ¯‹¨vbvi  
36|  BIOS Kx ? 

DËi t Basic Input Output System 
37|  Anti-Virus md&UIq¨v‡ii KvR Kx ? 

DËi t Kw¤úDUvi‡K Virus gy³ Kiv|  
38|  Database ej‡Z Kx †evSvq ? 

DËi t A‡bK ¸‡jv WvUv m¤^wjZ †Uwej‡K WvUv‡eR e‡j|  
39|  E-Mail G‡Wª‡mi mvaviY MVb †jL t 

DËi t mamun@gmail.com 
40|  Pen drive †K I/O wWfvBm ejv nq †Kb ? 

DËi t †cb WªvB‡fi gva¨‡g Kw¤úDUv‡i †h‡Kvb ai‡bi 
WvUv Av`vb/cÖ`vb Kiv hvq ZvB †cb WªBf †K  I/O 

wWfvBm ejv nq| 
 

 

 Translate into English : 
41|  m~h© c~e© w`‡K D‡V| 

DËi t The sun rises in the east. 

42|  †Zvgvi gvZvi bvg Kx ? 
DËi t What is your mother’s name? 

43|  Avgvi AveŸv GKRb Mixe †jvK| 
DËi t My father is a poor man. 

44|  †Zvgvi bvg Kx?  
DËi t What is your name? 

45|  XvKv evsjv‡`‡ki ivRavbx| 
DËi t Dhaka is the capital city of Bangladesh. 

 Fill in the blanks : 

46.  He is........................ honest man. 

 Ans. an. 
47.  Bangladesh became independent in...... 

Ans. 1971. 
48.  You .............. do it easily. 

 Ans. can. 
49. Swimming ........... a good exercise. 

 Ans. is  
50.  They ................... Play football. 

 Ans. are  
------------------------ 

 

 mwVK DËiwU‡Z wUK (√) wPý `vIt 
1| MS-Word 2003 -G Font Size cwieZ©b Ki‡Z 

†Kvb Uyjev‡i †h‡Z n‡e ? 
 (K) Table-G (L) Standard-G 

 (M) Formating.G (N) Format-G 

2|  †g‡gvwi cÖavbZ KZ cªKvi ? 
 (K) 2 cÖKvi  (L) 3 cÖKvi 
 (M) 5 cÖKvi  (N) 7 cÖKvi 
3| 1 wMMvevB‡U KZ wK‡jvevBU ? 
 (K) 103 wK‡jvevBU (L) 106   
 (M)109 wK‡jvevBU (N) 1012 

4| KZ¸‡jv †mj‡K GKwÎZ Kiv‡K e‡j- 
 (K) †gBj gvR©; (L) gvR© †mj;  

 (M) ¯úªxU †mj; (N) w¯úøU †Uwej| 
5| weRq Pvjy Ki‡Z Pvc‡Z nq............ 
 (K) Ctrl+Shift+B;  
 (L) Ctrl+Alt+B;  
 (M) Ctrl+Alt+A;  (N) Ctrl+B 
6| G5 †_‡K G50 ch©šÍ †hvM Kivi dvskb- 
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 (K) =Sum(G5:L50)   
 (L) =Sum(G5:K50) 
 (L) =Sum(G5:G50)   
 (N) =Sum(G5:-50) 
7| A1 †_‡K eo B1 †_‡K †QvU cÖKvk Ki‡Z e¨eüZ nq- 
 (K) A1<B1  (L) B1<A1 

 (M) A1≤B1 (N) B1≤A1 

8| Relational Data Base–G me©wb¤œ dvBj msL v̈- 
 (K) 2 wU  (L) 3wU  
 (M) 1 wU  (N) 4 wU 
9| Data Base Table–G cÖ‡qvRb g‡Zv wWRvBb 

Ki‡Z e¨eüZ nq - 
 (K) Design veiw  (L) Design home 

 (M) Design form 
 (N) Design table wizard 

10| Power point-G ̄ øvBW †kv Ki‡Z †Kvb Kx Pvc‡Z nq- 
 (K) Shift+F6  (L) Shift+F5 

 (M) F5  (N) Ctrl+F5 

 
 evK ẅU mZ¨ n‡j ÔmÕ Ges wg_ v̈ n‡j ÔwgÕ †jL t 
11. cÖ_g Avwe®‹…Z eªvDRv‡ii bvg †gvRvBK| 
 DËi t mZ¨ 
12. RAM GKwU ’̄vqx †g‡gvwi|    DËi t wg_¨v| 
13. eZ©gv‡b A¨vcj Kw¤úDUv‡i e¨eüZ Acv‡iwUs wm‡÷‡gi 

bvg Windows-8 

 DËi t wg_¨v 
14. †n·v‡Wwmgvj msL¨v c×wZi †em/wfwË 16wU| 

DËi t mZ¨| 

15. gvB‡µvmd&U IqvW© w`‡q ‰ZwiK…Z dvBj‡K WKy‡g›U 
e‡j|  

 DËi t mZ¨| 

16. wjM¨vj †ccv‡ii gvc ˆ`N©¨-13 BwÂ Ges cÖ ’̄ 8.5 BwÂ| 
DËi t wg_¨v 

17. =IF hyw³g~jK dgy©jv evK¨wU...    DËi t mZ¨ 
18. Cut Kivi Kx-†evW© KgvÛ Ctrl+X| 

 DËi t mZ¨ 
19. KZ¸‡jv m¤úK©hy³ Record Gi mgwóB n‡jv Table|

   DËi t | wg_¨v 
20. Power point-G Custom Animation †mU Kiv 

hvq bv|   
 DËi t  wg_¨v 
 
 AwZ ms‡¶‡c DËi `vI t 
21. ÒÿÓ †jL‡Z Kx-†evW© †_‡K Bs‡iRx †Kvb †Kvb ÒKxÓ 

Pvc‡Z n‡e? 
 DËi t JGShiftN 
22. Slide Animation cÖ`©kb Kivi KgvÛ Kx ? 
 DËi t F5 
23. Slide-G wWRvBb †Ug‡cøU e¨env‡ii myweav Kx? 
 DËi t ¯^í mg‡q `„wób›`b †cÖ‡R‡›Ukb ‰Zwi Kiv hvq| 
24. GKwU Antivirus mdU&Iq¨vi I `yÕwU Input device 

– Gi bvg †jL t 
 DËi t Avira I Keyboard, Mouse 
25. WWW-Gi c~Y©iƒc Kx ? 
 DËi t World Wide Web 
26. dvBj †gbyi cuvPwU Kgv‡Ûi bvg †jL t 
 DËi t New, Open, Save, Print, Close 
27. IqvK©kxU Kv‡K e‡j ? 
 DËi t IqvK©kxU IqvK©ey‡Ki Ask we‡kl| 
28. G‡·‡ji if dgy©jvi GKwU D`vniY `vI t 
 DËi t =if(C2>90),"Yes, No 
29. MS Word-G Page setup Kivi avc D‡jøL Ki t 
 DËi t File >Page Setup >[Margin, Paper] Ok 
30. (11)2 evBbvwi‡K †Wwm‡g‡j iƒcvšÍi Ki t 
 DËi t 3 
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 mwVK kã w`‡q k~b¨ ’̄vb c~iY Ki t 
31. gwbUi GKwU  wWfvBm| 

DËi t AvDUcyU 

32. ÔKxÕ †ev‡W©i dvskb ÔKxÕ  wU| 
DËi t 12 

33. GKB wPwV GKvwaK wVKvbvq †cÖi‡Yi Rb¨ MS Word-
G  e¨envi Kiv nq|  
DËi t †gBj gvR© 

34. MS Excel -G cÖwZwU IqK©kx‡U  wU Row 

Ges wU Column i‡q‡Q| 
DËi t 65536, 256 

35.  ÒOr”  GKwU  dg©yjv| 
DËi t Logical 

36. Access – G WvUv cÖ`k©b‡K wbqš¿b Kivi Rb¨ 
 e¨eüZ nq| 
DËi t Query 

37. BIOS k‡ãi c~Y©iæc | 
DËi t Basic Input Output System  

38. PHP g~jZ  ‡cÖvMÖvwgs j¨vs¸‡qR| 
DËi t Web 

39. SQL Gi c~Y©iƒc  | 
DËi t Structural query Language  

40. Power point dvB‡ji ewa©Z bvg w`‡q  
cÖKvk Kiv nq| 

 DËi t .pptx 

 

 

 Fill in the blanks with appropriate word 

under break: 
41. I want to...................a letter. 

(make/write/learn) Ans. write 

42. My father is.........than your father. 

(funny/funnier/funniest) 

 Ans. funnier 

43. He is..................honest man. (a/an/the)

  Ans. an 
 Answer the following questiosin in short: 

44. What is your present address ? 

 Ans. My present address is 350 Tejgaon, 
Dhaka-1208 

45. Who is your best friend ? 

 Ans. Rasel is my best friend. 

46. What do you do after training? 

Ans. I am try to after training  
 

 Translate into English : 

47. XvKv evsjv‡`‡ki ivRavbx| 
DËit Dhaka is the capital city of Bangladesh 

48. m~h© c~e© w`‡K D‡V| 
DËi t The sun rise in the east. 

49. †Zvgiv Kq fvB-‡evb ? 
 DËit How many brothers and sisters. 

50. Avgvi AveŸv GKRb Mixe †jvK| 
 DËi t My father is a poor man. 
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 AwZ ms‡ÿ‡c DËi `vI t 
1|  BIOS - Gi c~Y©bvg †jL t 
 DËi t Basic Input Output System 
2|  K‡qKwU Gw›UfvBivm Ñ Gi bvg †jL t 
 DËi t Avast, Kaspersky, Norton etc. 

3|  Gg. Gm. IqvW© Kx ai‡bi md&UIq¨vi? 
 DËi t Word Proccessing md&UIq¨vi| 

4|  Paste - Gi kU©KvU KgvÛ Kx ? 
 DËi t Ctrl+V 

5|  Gg.Gm. cvIqvi c‡q›U Kx ai‡bi md&UIq¨vi  
 DËi t †cÖ‡R‡›Ukb md&UIq¨vi| 
6|  md&UIq¨vi Kx ? 
 DËi t ÿz`ª ÿz`ª GKvwaK †cÖvMªv‡gi mgwó| 
7|  K‡qKwU Spread sheet software Ñ Gi bvg †jL t 
 DËi t Excel, Quatropro, Lotus 1,2,3. 

8|  Keyboard Ñ G End key Gi KvR Kx ? 
 DËi t  Kvm©i‡K jvB‡bi †k‡l wb‡q hvIqv|  
9|  Table gvR© Kiv ej‡Z Kx †evSvq ? 
 DËi t GKvwaK †mj‡K GKwU †m‡j iæcvšÍi Kiv| 
10|  `ywU Browser software Ñ Gi bvg †jL t 
  DËi t Mozila firefox I Google chrome 

 
  evK¨wU mZ¨ n‡j ÔmÕ Ges wg_¨v n‡j ÔwgÕ †jLt 
11|  gvDm BbcyU wWfvBm| 

 DËi t mZ¨ 

12|   Kw¤úDUv‡ii cÖavb fvlv evsjv| 
DËi t wg_¨v 

13|  IqvK©kxU IqvK©ey‡Ki Ask we‡kl| 

DËi t mZ¨ 
 
14|  Copy Past I Cut Past Ñ Gi gv‡S †Kv‡bv cv_©K¨ 

bvB| 
DËi t wg_¨v| 

15|  Recycle bin Ñ Gi Data cybivq wdwi‡q Avbv hvq| 
DËi t mZ¨ 

16|  md&UIq¨vi nj †cÖvMÖv‡gi mgwó| 
DËi t mZ¨ 

17|  Google GKwU mvP© BwÄb bq| 
DËi t wg_¨v 

18|  †¯úªWkxU c¨v‡KR w`‡q wn‡me-wbKvk Ñ Gi KvR nq| 
DËi t mZ¨ 

19|  A-Z wbD‡gwiK Key| 
DËi t wg_¨v 

20| MS Excel n‡jv †¯úªWkxU GbvjvBwmm c¨v‡KR| 
DËi t mZ¨ 
 

 mwVK kã w`‡q k~b¨ ’̄vb c~iY Ki t 
21. Printer GKwU  wWfvBm| 

DËi t AvDUcyU| 

22. Excel Ñ G Column msL¨v  wU| 
DËi t 256| 
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23. ROM Ñ Gi c~Y©iƒc ...................... |  
DËi t Read Only Memory 

24. A4 mvBR KvM‡Ri cwigvc n‡”Q ............... | 
DËi t 8.27"×11.69" 

25. KeyboardÑG Functional keys.... wU| 
DËi t 12| 

26. GK wbej mgvb ................... weU| 
DËi t 4| 

27. fvBivm Protect Kivi Rb¨ .......... e¨envi Kiv nq| 
DËi t Gw›UfvBivm| 

28. Ctrl+[ †P‡c Font mvBR ............. Kiv hvq| 
DËi t †QvU| 

29. Undo Kivi mswÿß Command n‡jv ............| 
DËi t Ctrl+Z 

30|  Data save Kivi mswÿß Command Kx ? 
DËi t Ctrl+S 

 

 mwVK DËiwU‡Z wUK (√) wPý `vIt 
31| Kw¤úDUv‡ii fvBivm n‡jv 
 (K) RxevYy ; (L) †ivM ;  
 (M) md&UIq¨vi  (N) nvW©Iq¨vi| 

32|  †KvbwU BbcyU wWfvBm bq ? 
 (K) gvDm ; (L) gwbUi ;  
 (M) gvB‡µv‡dvb (N) Kx-†evW© 
33| B-†gBj Ñ Gi bZzb GKvD›U †Lvjvi Rb¨ e¨eüZ nq- 
 (K) Log in ; (L) Sign in   
 (M) Sign out ; (N) Sign up  

34| †KvbwU Logical dvskb ? 
 (K) =Max ( ) ; (L) = Sum ( ) ; 

 (M) = If ( ) ;   (N) = Abs ( )| 

35| Print - Gi kU©KvU KgvÛ †KvbwU ? 
 (K) Ctrl + Y ; (L) Ctrl + X ;  
 (M) Ctrl + P ;  (N) Ctrl + Z| 
36| Column hide e¨eüZ nq - 
 (K) Column †K jywK‡q ivL‡Z ;  
 (L) Row †K jywK‡q ivL‡Z ; 

 (L) Column I Row †K jywK‡q ivL‡Z ; 
 (N) gy‡Q †dj‡Z| 
37| AvaywbK Kw¤úDUv‡ii RbK †K ? 
 (K) †b‡cvwjqvb ; (L) Pvj©m e v̈‡eR ;  

 (M) w÷‡db nwKsm ; (N) gvK©bx| 
38| GK wK‡jvevBU mgvb KZ evBU? 
 (K) 1024 evBU ;  (L) 1014 evBU ; 

(M) 1124 evBU ; (N) 1323 evBU| 
 
39| IqvK©kx‡Ui Row wb‡ ©̀k Kiv nq Ñ 
 (K) †jUvi w`‡q ; (L) b¤̂i w`‡q ;  

 (M) b¤̂i I eY© w`‡q ;  (N) wkd&U w`‡q| 
40| KxÑ†evW© Ñ Gi K‡›Uªvj ÒKxÓ –Gi msL¨v KqwU ? 
 (K) 2 wU ;  (L) 3 wU ; 
 (M) 4 wU ; (N) 5 wU| 
 

 Fill in the blanks with appropriate word 

under break: 

41.   I want to ............... a letter. (make/ write/ 

learn)   Ans: write 
42.  My father is ..................... than your father. 

(funny/funnier/funniest) 

Ans: funnier 
43.  I am too ...........................to walk. 

(weak/tight/quiet) Ans. weak 
44.  The pencil is made of ..................... 

(Iron/wood/bamboo)  Ans. wood 
 

 Translate into English : 

45.  evsjv‡`k Avgvi Rb¥fzwg| 
 DËit Bangladesh is my motherland. 

46.  m~h© cwðg w`‡K A Í̄ hvq| 
 DËi t The sun sets in the west. 

47.  †Zvgvi wcZvi bvg Kx ? 
 DËi t What is your father’s name. 
 
 Answer the following questiosin in short in 

English: 

48.  Do you know how to swim ? 
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 Ans. Yes, I know. 
49.  What is your favourite hobby ? 

 Ans.My favourite hobby is gardening. 
50. Who is your Best friend ? 

 Ans. Hossain is my best friend. 



  

 1 

 

 

 mwVK DËiwU‡Z wUK (√) wPý `vIt 
1| GK wK‡jvevBU mgvb KZ? 

(K) 1024 evBU  (L) 1014 evBU 

(M) 1124 evBU (N) 1011 evBU 
2|  WU ‡gwUª· wcÖ›Uvi n‡jv Ñ 
 (K) BbcyU wWfvBm 
 (L) AvDUcyU wWfvBm    
 (M) †g‡gvwi  
 (N) cÖwµqvKiY wWfvBm 
3|   Save -Gi Kx-†evW© KgvÛ †KvbwU? 
 (K) Ctrl+C (L) Ctrl+X 

 (M) Ctrl+P  (N) Ctrl+S  
4|  Qwe, †U·U, MÖvd BZ¨vw`i †ÿ‡Î †Kvb Object wU e¨eüZ 

nq ? 
 (K) Hyperlink (L) OLE  

 (M) Text (N) Yes/No 
5|  †Kvb †gby‡Z Sort Gi Formula _v‡K? 
 (K) Window (L) Insert 

 (M) Tools  (N) Table  
6|  dvg©Iq¨vi n‡”Q - 
 (K) RAM (L) HDD 

 (M) ROM  (N) †KvbwUB bq 
7|  wb‡Pi †KvbwU mnvqK †g‡gvwi?  
 (K) RAM (L) HDD  

 (M) ROM (N) †KvbwUB bq 
8|  †Kvb †cÖvMÖvg ẁ ‡q Presentation ‰Zix Kiv hvq ? 
 (K) MS-Word   (L) MS-Access 

 (M) MS-Excel  (N) MS-Power point  
9|  LAN k‡ãi c~Y©iƒc †KvbwU?  
 (K) Local Area Network  
 (L) Local Assemble network  

 (M) Lokal area network 

 (N) Logal Assemlemble nework   
 
 
10|  †KvbwU Antivirus bq? 
 (K) Avast  (L) Linux  
 
(M) AVG  (N) Norton 
 

 

 
 

 mwVK kã w`‡q k~Y¨ ’̄vb c~iY Ki t 
11|  RAM Gi c~Y©iƒc ................| 

DËi t Random Access Memory 

12|  A4 mvBR KvM‡Ri cwigvc nj...............| 
 DËi t cÖ ’̄ 8.27 Ges ˆ`©a¨ 11.69 BwÂ 

13|  Excel - Gi Row msL̈ v ........... wU| 
 DËi t 65536 

14|  Recycle Bin †dvìv‡i ......... dvBj Rgv _v‡K 
 DËi t AcÖ‡qvRbxq wW‡jUK…Z  
15|  GKwU wPwV wewfbœ wVKvbvq †cÖi‡Yi Rb¨ ........ 
 KgvÛ e¨eüZ nq| 
 DËi t Mail Merge 
16|  Kw¤úDUv‡ii gvä ‡g cvī úwiK †hvMv‡hvM‡K ....... e‡j| 
 DËi t †bUIqvK© 
17|  WWW Gi c~Y©iƒc.............................| 
 DËi t World Wide Web 
18|  Page break-Gi KvR n‡jv ........... Kiv| 
 DËi t GKwU †cBR‡K wØLwÛZ Kiv| 
19|  ¯‹¨vbvi GK cÖKvi ................. wWfvBm| 
 DËi t BbcyU 
20|  Data paste Kivi mswÿß Command n‡jv......| 
 DËi t Ctrl+V 

 
 evK¨wU mZ¨ n‡j ÔmÕ wg_¨v n‡j ÔwgÕ †jL t 
21|   Kw¤úDUv‡ii cÖavb fvlv evsjv| 
 DËi t Ôwg_¨vÕ 
22|  IqvK©kxU IqvK©ey‡Ki Ask we‡kl|  
 DËi t ÔmZ¨Õ  
23|  †gBj A¨vKvD›U eÜ Kivi Rb¨ Sign in wK¬K Ki‡Z nq| 
 DËi t Ôwg_¨vÕ 
24|  (10)10 †K evBbvwi‡Z cÖKvk Ki‡j (1010)2 n‡e| 
 DËi t ÔmZ¨Õ 
25|  Facebook GKwU B›Uvi‡bU eªvDwRs md&UIq¨vi  
 DËi t Ôwg_¨vÕ 
26|  Data sort ỳB cÖKvi|  
 DËi t ÔmZ¨Õ 
27|  Kw¤úDUv‡ii cÖwµqvKiY Ask n‡”Q Mother board 
 DËi t wg_¨v 
28|  †dvìv‡ii wfZi dvBj I †dvìvi DfqB _v‡K|  

 mvwU©wd‡KU-Bb-Kw¤úDUvi Awdm A¨vwcø‡Kkb 
evsjv‡`k KvwiMwi wk¶v †evW©, XvKv 

†ewmK †UªW 
†ewmK †UªW 360 NÈv (wZb gvm) †gqvw` (Rvbyqvwi-gvP©) cix¶v- 2015 

welq t Kw¤úDUvi Acv‡ikb/Kw¤úDUvi Awdm A¨vwcø‡Kkb 
[mgq : 1 NÈv] (welq †KvW t 16/76)  [c~Y©gvb : 50] 

mKj cÖ‡kœi DËi w`‡Z n‡e| (gvb  

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 DËi t mZ¨ 
29|  Kw¤úDUvi fvBivm GKwU †cÖvMÖvg| 
 DËi t mZ¨  
30|  Google GKwU Browser|  
 DËi t wg_¨v 
 
 AwZ ms‡ÿ‡c DËi `vI t 
31|  Mail Merge Kx?   
 DËi t GKwU wPwV wewfbœ wVKvbvq †cÖi‡Yi Rb¨ Mail Merge 

KgvÛ e¨eüZ nq| 
32|  ROM-Gi c~Y©iƒc Kx?   
 DËi t Read Only Memory 
33| Mozila firefox Kx? 
 DËi t  GKwU B›Uvi‡bU eªvDwRs md &UIq¨vi|  
34|  †¯úªWkxU c¨v‡KR w`‡q Kx ai‡bi KvR Kiv nq? 
 DËi t wnmve-wbKv‡mi KvR Kiv nq| 
35| K‡qKwU Antivirus - Gi bvg †jL| 
 DËi t K) Avast   L) Kaspersky 

         M) Norton  N) G-Data 

36|  File ej‡Z Kx †evS? 
 DËi t File k‡ãi A_© bw_|  
37|  Excel ÑG Row Ñ Gi msL¨v KqwU? 
 DËi t  
 Excel  2003- Row ÑGi msL v̈ 65536 wU Ges  
 Excel  2007- Row ÑGi msL v̈ 10,48576 wU| 
38|  Desktop Kx? 
 DËi t gwbU‡ii c`©v‡K Desktop ejv nq| 
39|  E-mail Kx? 
 DËi t Electronic Mail B›Uv‡b‡Ui gva¨‡g wPwV cÎ 

Av`vb/cÖ`vb Kiv‡K B-†gBj e‡j| 
 DËi t Electronic Mail B›Uv‡b‡Ui gva¨‡g wPwV cÎ 

Av`vb/cÖ`vb Kiv‡K B-†gBj e‡j| 
 

40|  weU I evBU Kx? 
 DËit evBbvix bv¤^vi c×wZ‡Z e¨eüZ AsK 0 (ïb¨) Ges 

1 (GK) †K weU e‡j|   
 evBU t AvU we‡U GK evBU nq|| Giƒc 8  we‡Ui †KvW †h 

- †Kvb eY©, AsK ev we‡kl wPý‡K cÖKvk Kiv n‡q _v‡K|  
 

 Translate in to English t 
41|  †`k‡cÖg gnr ¸Y 
 DËi t Patriotism is a great/noble virtue 
42|  evsjv‡`k Avgvi Rb¥f~wg| 
 DËi t Bangladesh is my motherland. 
43|  Avwg evwo hve| 
 DËi t I will go home 
44|  †Zvgvi wcZvi bvg Kx? 
 DËi t What is your father’s name? 
45|  Zzwg †Kgb AvQ? 
 DËi t How are you? 
 Choose and fill in the gaps the correct 

word/words t 
46. To be healthy, we must eat........... 

 (i) good food          (ii) rich food  

 (iii) balanced diet   
47. He is ..............honest man  

 (i) a          (ii) an       (iii)  the 

48.  My mother reads..........holy Quran. 

 (i) a          (ii) an          (iii) the  

49. I want to .......... a latter. 

 (i) make    (ii) write     (iii)  learn 
50. Swimming ..........a good exercise.  

 (i) is       (ii) am      (iii) are 
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 mvwU©wd‡KU-Bb-Kw¤úDUvi Awdm A¨vwcø‡Kkb 
evsjv‡`k KvwiMwi wk¶v †evW©, XvKv 

†ewmK †UªW 
†ewmK †UªW 360 NÈv (wZb gvm) †gqvw` (Rvbyqvwi-gvP©) cix¶v- 2015 

welq t Kw¤úDUvi Acv‡ikb/Kw¤úDUvi Awdm A¨vwcø‡Kkb 
[mgq : 1 NÈv] (welq †KvW t 16/76)  [c~Y©gvb : 50] 
†iwR‡÷ªkb bs....................... †mkb :.......................... cwi`k©‡Ki ¯^v¶i....................... 

mKj cÖ‡kœi DËi w`‡Z n‡e| (gvb 1  50 = 50) 

 
 

 mwVK kã w`‡q k~b ’̄vb c~iY Ki t  
1|  LAN-Gi c~Y©iƒc nj ......  | 
 DËi t Local Area Network 
2|  Recycle Bin †dvìv‡i.....dvBj Rgv _v‡K | 
 DËi t Delete K„Z 
3| MS Power Point GKwU....... mdUIq¨vi | 
 DËi t Presentation 

4| mvaviYZ wPwVcÎ †jLvi Rb¨....†cÖvMÖvge¨envi Kiv nq| 
 DËi t MS-Word  

5| OMR-Gi c~Y©iƒc nj........ | 
 DËi t Optical Mark Reader  

6| Scanner GKwU............wWfvBm | 
 DËi t BbcyU 
7| Google GKwU.......| 
 DËi t mvP© BwÄb 
8| MS Excel GKwU.......mdUIq¨vi | 
 DËi t †¯úªWkxU G¨vbvjvBwmm 
9| ROM- Gi c~Y©iƒc nj...... | 
 DËi t Read Only Memory 

10| Microsoft Access- GKwU....... md&UIq¨vi| 
 DËi t Database 

 

 evK¨wU mZ¨ n‡j ÔmÕ Ges wg_¨v n‡j ÔwgÕ ‡jL t 
11| Sort -Gi KvR nj †iKW©¸‡jv mvRv‡bv | 
 DËi t ÔmÕ | 
12| †dvìv‡ii †fZ‡i dvBj I †dvìvi DfqB _vK‡Z cv‡i| 

 DËi t ÔmÕ | 
13| Website wPwVcÎ †jLvi Kv‡R e¨eüZ nq| 
 DËi t ÔwgÕ | 
14| Kw¤úDUv‡ii cªwµqvKiY Ask nj gvB‡µvcÖ‡mmi | 
 DËi t ÔmÕ 
15| Kaspersky GKwU Gw›UfvBivm | 
 DËi t ÔmÕ | 
 
 
16| c„w_exi cÖ_g Kw¤úDUvi Program- Gi iPwqZv 

†jwW G¨Wv AMvóv|   
 DËi t ÔmÕ | 
17| Facebook- Gi RbK gvK© RyKvi evM© | 
 DËi t ÔmÕ 
18| LINUX GKwU Application software | 
 DËi t ÔwgÕ 
19| nvW©wW¯‹ GKwU cÖBgvwi †g‡gvwi | 
 DËi t ÔwgÕ  
20| Rqw÷K GKwU BbcyU wWfBm | 
 DËi t ÔmÕ  
 
 mwVK DIiwU‡Z wVK (√)wPý `vI t 
21| File close- Gi Kx- †evW© KgvÛ †KvbwU ? 
 (K) Ctrl+O (L) Ctrl +W  

 (M)  Alt+O (N) Ctrl+F4 

22| evsjv‡`‡k ‰Zwi j¨vcU‡ci bvg Kx ? 
 (K) NyNy (L) gqbv 
 (M) †`v‡qj (N) wUqv 
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23| Excel-Gi GKvwaK Cell GKwÎZ Kiv‡K Kx e‡j ? 
 (K) Add (L) Join 

 (M) Merge (N) Union 

24| Qwe, †UKªU I MÖv‡di Rb¨ †Kvb Object e¨eüZ nq? 
 (K) OLE (L) Display text 

 (M) Text (N) Hyper link 

25|  †KvbwU Storage device 

 (K) Keyboard (L) Hard disk 

 (M) Scanner (N) Mouse 

26| Macro Kx ? 
 (K) dv©gIq¨vi  (L) nvW©Iq¨vi  
 (M) mdUIq¨vi 
 (N) †cÖvMÖv‡gi fvlvq e¨eüZ wewfbœ ai‡bi wb‡ ©̀kbv 

 
 
 
27| wb‡Pi †KvbwU NIC Gi c~Y©iƒc Kx? 
 (K) Network  Inter Card                  

 (L) Network Interface Card            

(M) NetInternationalCommunication                  

(N) ‡KvbwU bq  

28| wb‡Pi †KvbwU Antivirus?         
 (K) Windows  (L) Linux 

 (M) Unix  (N) Norton  

29| WWW-Gi c~Y©iƒc Kx?     
 (K) World Wide Web 

  (L) World web Wide 

  (M) World Word Wed  

  (N) World Wed World  

30| F10 n‡Z F25 †mj Gi ‡hvM Kivi dvskb:- 
 (K) =Sum (F5:F11)  

  (L) =Sum (F6:F12) 

  (M) =Sum(F12:F10) 

  (N) =Sum(F10:F25)  
 AwZ ms‡ÿ‡c DËi `vIt 
31| MS Word Kx?  

DËi t MS word is a word prossceing 

Application program Gi gva¨‡g Word 

prossceing Gi KvR Kiv nq|  
32| Pvj©m e¨v‡eR †K wQ‡jb? 
 DËi t AvaywbK Kw¤úDUvi Gi RbK | 
33| `ywU Output h‡š¿i bvg †jL  
 DËi t Printer, Monitor 

34| Kw¤úDUvi fvBivm Kx? 
 DËi t Kw¤úDUvi fvBivm GK ai‡bi ÿwZKviK †cÖvMÖvg  
35| ATM w`‡q wK †evSv‡bv  nq? 
 DËi t Automatic Teller Machine. 

36| UNIX wK? 
 DËi t UNIX GKwU Network Operating System. 

37| Ctrt+C w`‡q wK †evSv‡bv  nq? 
 DËi t Ctrt+C ẁ ‡q Copy Command †evSv‡bv  nq| 
38| Spell Checking Kx? 

DËi t WKy‡g›U Bs‡iRx UvBc Ki‡j Ges Zv 
Kw¤úDUvi fvlvq fzj n‡j H k‡ãi wb‡P †PK Ki‡Z 
n‡j Spell Checking Ki‡Z nq | 

 
39| DVD Kx  
 DËi t Digital Versatile Disk 

40| MS Excel Tab Button G Kx Kv‡R e¨envi Kiv 
nq| 
DËi t MS Excel-G GK †mj †_‡K cieZx© †m‡j 
hvIqvi Rb¨ Tab Key e¨envi Kiv nq| 
 

 Translate in to English t 
41| m~h© c~e© w`‡K I‡V 
 DËi t The sun rises in the east 
42|  XvKv evsjv‡`‡ki ivRavbx 
 DËi t Dhaka is the Capital of Bangladesh 
43|  †m cÖwZw`b ¯‹z‡j hvq  
 DËi t He goes to school everyday   
44|  mKvj †_‡K e„wó n‡”Q 
 DËi t It has been raining since morning  

 Fill in the gaps with the correct word 

/words given in the brackerts: 

45| To be healthy, We must eat …….. 
 (Good food/ rich food/ balanced diet) 
 DËit balanced died 

46| Swimming ……….a good exrcise 
(is/am/are) 

 DËit is 
47| I want to……a letter  
 (make/write/learn) 
 DËit write 

 Answer the following questions in 

English: 
48| How old are you ? 
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 DËi t Iam 18 Years old. 

49| Do you know how to swim ? 

DËi t Yes/No, I know/I don’t know how 
to swim 

50| Who is your best friend ? 

 DËi t Abdulla is my best friend  

evsjv‡`k KvwiMwi wk¶v †evW©, XvKv 
†ewmK †UªW 

†ewmK †UªW 360 NÈv (wZb gvm) ‡gqvw` (RyjvB- wW‡m¤̂i Ges A‡±vei- wW‡m¤̂i)cix¶v- 2015 
welq t Kw¤úDUvi Acv‡iUi/Kw¤úDUvi Awdm A¨vwcø‡Kkb 

[mgq : 1 NÈv] (welq †KvW t 16/76)  [c~Y©gvb : 50] 
†iwR‡÷ªkb bs....................... †mkb :.......................... cwi`k©‡Ki ¯^v¶i....................... 

mKj cÖ‡kœi DËi w`‡Z n‡e| (gvb 1  50 = 50) 
 
 AwZ ms‡ÿ‡c DËi `vI t 
1|  dvBj †mf Ki‡j Kx N‡U?| 

DËit dvBj †mf Ki‡j GKwU wbw ©̀ó bv‡g †Kvb GKwU 
WKz‡g›U‡K msiÿY Kiv hvq|  

2| c~Y©iƒc †jLt 
 (K) TCP/IP (L) VOIP 

DËit (K) Transmission Control 

Protocol/Internet Protocol. 
(L) Voice Over Internet Protocol. 

3|  Page Set Up Kv‡K e‡j? 
DËit Gg Gm Awdm Gi †Kvb †cÖvMÖv‡g †Kvb WKz‡g›U 
ˆZwi Kivi ci †mUv wcÖ›U w`‡Z n‡j, †Kvb AvKv‡ii c„ôv 
e¨envi n‡e, c„ôvi gvwR©b KZUzKz n‡e Gme wKQz‡K 
GK‡Î †cR †mU Avc ejv nq| 

4|  Footnote Kx? 
 DËit cÖwZwU c„ôvi wb‡P wUKv †jLv nj dzU‡bvU| 
5|  MS Excel-7 Gi IqvK©kx‡U KqwU Row I KqwU  

Column jvM‡e? 
DËit MS Excel-7 Gi IqvK©kx‡U 10, 48576 wU 
Row Ges 16,384 wU Column _v‡K| 

6|  G‡·j c v̈‡KR ẁ ‡q †Kvb †Kvb ai‡bi KvR Kiv hvq| 
DËit G‡·j c¨v‡KR w`‡q wewfbœ ai‡bi wnmvewbKvk 
Gi KvR Kiv hvq| 

7|  GKwU B †gBj A¨v‡Wª‡mi mvaviY MVb †jL | 
DËit info.deepnet@gmail.com 

8|  Database Application Kx? 
DËit kvwãK A‡_© WvUv‡em n‡”Q †Kvb m¤úwK©Z wel‡qi 
Dci e¨vcK Z_¨ ev Dcv‡Ëi mgv‡ek| wewfbœ eo eo 
cÖwZôv‡b WvUv‡em msiÿY, A¨vbvjvBwmm, wnmveiÿY 
BZ¨vw`‡Z e¨envi Kivi Rb¨ RbwcÖq, kw³kvjx I 
msiwÿZ GKwU †cÖvMÖvg| 

9|  GKwU †cÖ‡R‡›Ukb md&UIq¨v‡ii bvg †jL| 

 DËit gvB‡µvmd&U cvIqvi c‡q›U| 

10|  Computer Virus- Gi KvR Kx? 
DËit Kw¤úDUv‡ii wewfbœ †cÖvMÖvg‡K aŸsm K‡i †`q| 
fvBivm AvµvšÍ n‡j Kw¤úDUv‡i wewfbœ mgm¨v †`Lv 
†`q| 

 evK¨wU mZ¨ n‡j ÔmÕ wg_¨v n‡j ÔwgÕ †jL t 
11| Binary msL¨v c×wZi †gŠwjK A¼ 10wU|  
 DËit ÔwgÕ 
12| 1020 Megabyte=1Gigabyte 

 DËit ÕwgÕ 
13| CD ROM-G CD Write Kiv hvq bv| 
 DËit ÔmÕ 
14| MS Word GKwU Word Processing Software. 

 DËit ÔmÕ 
15|  †jRvi wcÖ›Uvi GKwU AvDUcyU wWfvBm| 

 DËit ÔmÕ 
16| Power Point GKwU Presentation Software. 
 DËit ÔmÕ 
17|  Mo †ei Kivi myÎ n‡”Q=AVERAGE(CELL 

NUMBER: CELL NUMBER) 
 DËit ÔmÕ 
18|  Access w`‡q bZzb WvUv‡em †cÖvMÖvg ˆZwi Kiv hvq| 
 DËit ÔmÕ 
19| Internet A_© International Network. 
 DËit ÔmÕ 
20| Mail cvVv‡Z n‡j Sign-Up Ki‡Z nq| 
 DËit ÔwgÕ 
 
 mwVK kã w`‡q ïb¨ ’̄vb c~iY Kit 
21| †cbWªvB‡f................. †ggwi e¨eüZ nq| 
 DËit d¬vk 
22| mycviKw¤úDUvi mePvB‡Z.......... Kw¤úDUvi| 
 DËit e„nr  
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23| MS Office n‡”Q A‡bK¸‡jv ........ Gi mgwó|  
 DËit †cÖvMÖvg 
24| LAN Gi c~Y ©iƒc n‡”Q .............. 
 DËit Local Area Network 
25| Mozilla Firefox n‡jv GK ai‡bi .........  
 DËit eªvDRvi 
26| Microsoft Excel g~jZ GKwU..... Software 

 DËit †¯úªWkxU 
27| Goal Seek AckbwU....... Menu Gi Aax‡b| 
 DËit Tools 
28| www.bteb.gov.bd n‡jv ....... Gi I‡qe A v̈‡Wªm  
 DËit evsjv‡`k KvwiMwi wkÿv †evW© 
29|  MS Access G ........... ˆZwi Kiv hvq| 
 DËit WvUv‡em †cÖvMÖvg  
30|  cÖ‡Z¨KwU Search Engine GK GKwU .........| 
 DËit eªvDRvi  
 

 mwVK DIiwU‡Z wVK (√)wPý `vI t 
31|  A¨vevKvm Kx ai‡bi hš¿? 
 (K) bywo I cv_‡ii ˆZwi MYbvKvix hš¿ 

(L) Kv‡Vi ˆZwi MYbvKvix hš¿                       
(M) cv_‡ii ˆZwi MYbvKvix hš¿ 
(N) †jvnvi ˆZwi MYbvKvix hš¿  

32|  Kq evBU mgvb GK wK‡jvevBU? 
 (K) 1044 evBU mgvb 1 wK‡jvevBU 

 (L) 1034 evBU mgvb 1 wK‡jvevBU  
 (M) 1024 evBU mgvb 1 wK‡jvevBU   
 (N) 1014 evBU mgvb 1 wK‡jvevBU 

33|  (A03)16 msL v̈wU‡K `kwgK msL¨vq cÖKvk Ki‡j KZ 
n‡e? 

 (K) 2663  (L) 2563  

 (M) 1763 (N) 2463  
34|  A4 Size KvM‡Ri cwigvc †KvbwU? 
 (K) cÖ¯’ = 8.37”, ˆ`N ©̈ = 12.63Ó   
 (L) cÖ¯’ = 8.29”, ˆ`N ©̈ = 10.69Ó 
 (M) cÖ¯’ = 8.17”, ˆ`N¨© = 13.69Ó 
 (N) cÖ¯’ = 8.27”, ˆ`N ©̈ = 11.69Ó 
35|  †cb WªvBf n‡jv GKwU Ñ wWfvBR? 
 (K) BbcyU (L) AvDUcyU 
 (M) BbcyU- AvDUcyU  (N) †KvbwUB bq 
  †cb WªvBf g~jZ †óv‡iR wWfvm 
36| =ABS(1.258) Gi gvb KZ ? 
 (K) =1.23 (L) =1.24 
 (M) =1.258  (N) =1.26  

37|  Slide object ejv nq ? 
 (K) Slide- Gi GKvwaK Ask‡K 
  (L) Slide- Gi mswkøó Ask‡K                                      

(M) Slide- Gi wewkó Ask‡K  
 (N) Slide- Gi cÖwZwU Ask‡K  
38|  Cat 5 K¨ve‡j Zv‡ii msL¨v n‡jv ? 
 (K) 5 wU  (L) 6 wU 
 (M  18 wU (N) 8 wU  
 

39|  WvUv‡em †Uwe‡j primary key wbav©iY Kiv nq- 
 (K) Relation m„wói Rb¨  
 (L) Table  ‰Zwii Rb¨   
 (M)  Design Kivi Rb  ̈  

 (N) Table Import Kivi Rb¨ 
40|   HTTP-Gi c~Y©iƒc †KvbwU ?  

(K) Higher Tex Technology problem     
(L) Hyper Text Transfer Protocol  
(M) Hot Text Transfer Problem        (N) 
Haker Text Transfer Permission 
 
 

 Translate in to English t 
41|  evsjv‡`k Avgvi Rb¥f~wg| 
 DËi t Bangladesh is my motherland. 
42|  Avgvi evev GKRb K…lK 
 DËi t My Father is a farmer 
43|  †`k‡cÖg gnr ¸Y 
 DËi t Patriotism is a great virtue 

 Fill in the blanks with appropriate 

preposition 
44|  The birds are sitting.............. wall. 
 DËi t on 
45|  He goes ............ school every day. 

 DËi t to 

46|  Sweet is made ............ milk. 
 DËi t of 

 Answer the following questions in short: 

47| What is your mother? 

 DËi t My mother is a housewife. 

48| What is your favorite food ? 

. DËi t Apple is my favorite food 

49| What is your home district? 

 DËi t My home district is Dhaka? 

50| What is the full meaning of w.w.w.? 
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 DËi t World Wide Web 



 

 

 
 
 
 
 
 
 
 AwZ ms‡ÿ‡c DËi `vI t 
1| bZzb File †Lvjvi Rb¨ Kx Command e¨envi 

Kiv nq? 
DËi t Ctrl+N 

2| jyKv‡bv Column Lyu‡R †ei Ki‡Z Kx e¨envi 
Kiv nq?  
DËi t Select All Column→ Home→ 
Format→ Visibility→ Hides & Unhide→ 
Unhide Columns|  

3| Excel Program cÖ`k©b Pvjy Ki‡j KqwU wkU 
Pvjy nq? 

 DËi t 3 wU| 
4|  KZ¸‡jv Interconnected field wg‡j wK 

‰Zix nq? 
 DËi t Record. 
5| `ywU eªvDRvi Gi bvg †jL|  

DËi t (i) Mozilla Firefox (ii) Opera. 
6| GKwU B-‡gBj A¨v‡Wª‡mi mvavib MVb †jL| 

DËi t B-‡gBj A¨v‡Wª‡m mvavib MVb nj t 
<Userid> @ Domain name>.com 

[Note] [B-‡gBj A¨v‡Wª‡m GKwU BDwbK 
A¨v‡Wªm| A_©vr GK bv‡g ïay GKwU gvÎ B-
†gBj A¨v‡Wªm _v‡K| B-‡gBj A¨v‡Wªm Bs‡iwR 
†QvU nv‡Zi Aÿ‡i wjL‡Z nq| cÖwZwU B-†gBj 
A¨v‡Wª‡mi `yBwU Ask _v‡K| Ask `yBwUi gv‡S 
†mcv‡iUi wnmv‡e GKwU @ (cat Sign) e¨eüZ 
nq| ] 

7| Database program G Form ‰Zix Kiv 
nq †Kb ? 
DËi t my›`i I AvKl©Yxqfv‡e wWRvB‡bi gva¨‡g 
GK ev GKvwaK †Uwe‡j WvUv supply Kivi 
Rb¨  Form ˆZix Kiv nq|         

8| Excel Program – G †Kvb wbw`©ó Ask 
cÖKv‡ki Rb¨ e¨envi Kiv nq ? 

 DËi t Select cell range.  
9| Bijoy Keyboard Gi Bangla to English 

English to Bangla Kivi kU©KvU ÔKxÕ †KvbwU 
? 
DËi t Ctrl + Alt + B| 

10| fvBivm Kx ? 
 
 

 
 
DËi t Kw¤úDUv‡ii cwifvlvq fvBivm k‡ãi 
c~Y©iæc- Vital Information Resources 

Under Seize, hvi A_© ¸iæZ¡c~Y© Drm¸‡jv 
ev‡Rqvß Kiv n‡q‡Q|  

 mwVK kã w`‡q k~b¨ ’̄vb c~ib Ki t  
11| MS Office Program -G Data Save  Ki‡j 

Zv ....... Rgv nq| 
 DËi t My document G 
12| Database-G cª_g ‰Zix Ki‡Z nq ........ ? 
 DËi t Table. 
13| Undo Kiv nq.......... Rb¨ ? 
 DËi t evwZj KvR c~Yivq wdwi‡q Avbvi Rb¨| 
14| GKwU wPwV wfbœ wfbœ wVKvbvq cvVvevi Rb¨ 

e¨envi Kiv nq ......... | 
 DËi t Mail Marge. 
15| †cBR Gi gvwR©b wVK Ki‡Z ......... Select   

Ki‡Z nq|  
 DËi t Page Setup. 
16| ¯‹¨vbvi GKwU ---- wWfvBm| 
 DËi t BbcyU| 
17| (a+b)2+2ab2+ab GB Format- wU †jL‡Z 
 ...... Gi mvnvh¨ wb‡Z nq| 
 DËi t  Superscript.  
18| Excel Program- G File save  Ki‡j File 

name  Gi mv‡_  ...... hy³ nq| 
 DËi t .xls  
19| Text alignment........ cÖKvi|  
 DËi t 4 cÖKvi| 
20| Cell  †K K‡qKwU As‡k wef³ Ki‡Z PvB‡j 

......Ki‡Z nq| 
 DËi t Split cells.  
 

 evK¨wU mZ¨ n‡j ÔmÕ Ges wg_¨v n‡j ÔwgÕ †jL t 
21| Windows Gi Under G MS Office 

Program cwiPvwjZ nq| 
 DËi t mZ¨ 
22| gwbUi nj †ggwi wWfvBm| 
 DËi t wg_¨v 
23| Move Kivi Rb¨ MS Word Command 

n‡jv Cut Paste| 
 DËi t mZ¨ 

evsjv‡`k KvwiMwi wkÿv †evW©, XvKv 
†ewmK †UªW 

†ewmK †UªW 360 N›Uv (3/6 gvm) †gqvw`(GwcÖj-Ryb/Rvbyqvwi-Ryb) cixÿv-2016 
welq t Kw¤úDUvi Awdm A¨wcø‡Kkb 
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24| wmwiR Data †hv‡Mi Rb¨ Excel Program G 
=(A1:A15) wbqg AbymiY Kiv nq| 

 DËi t wg_¨v 
25| Level Box I Text Box †Kvb cv_©K¨ bvB| 
  DËi t wg_¨v  
26| MS Word G Line Spacing Gi Rb¨ 

 Paragraph Option e¨envi Kiv nq| 
 DËi t mZ¨ 
27| `ywU Table G GKwU  Field GKB _vK‡j  

Relationship Kiv hvq| 
 DËi t mZ¨ 
28| Report Gi KvR nq File †K cÖ`k©b Kiv|  
 DËi t wg_¨v 
29| Close Ki‡j Program eÜ nq Exit Ki‡j 

File eÜ nq| 
 DËi t mZ¨ 
30| Image MS Word ev MS Excel Add Kiv 

hvq| 
 DËi t mZ¨ 
 mwVK DIiwU‡Z wUK (√) wPý `vI t  

31| Windows – GK cÖvKvi- ? 
 (K) Program  

 (L) Operating System  

 (M) Application Program   

 (N) †KvbwU bq 

32 | MICR GKwU- 
 (K) BbcyU     (L) AvDUcyU   

 (M) BbcyU I AvDUcyU   (N) †ggwi wWfvBm 

33| gvDm GKcÖKviÑ 
 (K) Input Device      (L) Output Device   

 (M)Memory Device (N) Pointer   

34| MS Word G Copy Paste Ki‡Z kU©KvU© KxÑ 

 (K) Ctrl + C     (L) Ctrl + V 
 (M) DfqwU        (N) †Kv‡bvwUB bq 
35| Open Commend †Kvb Menu †Z _v‡K? 
 (K) Edit Menu    (L) View Menu 

 (M) File Menu  (N) †KvwUB bq 

36| `yB Cell ‡hv‡Mi wbqg (Excel Program )- 
 (K) =A1+A2    (L) A1+A2 

  (M) A1:A2          (N) meKwU  
37| Excel Program G mvaviYZ mvwii D”PZv 

_v‡KÑ 
      (K) 18.75        (L) 15.75 

       (M) 8.75           (N) 12.75  
38| Microsoft Access n‡jv- 

      (K) †¯úªWwkU Program    
      (L) Language Program 
      (M) Database Program           
      (N) meKwU 
39| GgGm IqvW© nj- 
      (K) WvUv cÖ‡mmi         (L) †gBj gvwR©s 
c¨v‡KR 
      (M) IqvW© cÖ‡mmi      (N) †¯úªWwkU 
40| Relationship Kq cÖKvi ? 
      (K) 3 cÖKvi              (L) 2 cÖKvi 
      (M) †Kvb cÖKvi‡f  ̀†bB  (N) †KvbwUB bq  
 Translate into English: 
41| c„w_ex m~‡h©i Pviw`‡K †Nv‡i| 

DËit The earth moves round the sun. 
42| Avgvi evev GKRb `ÿ KvwiMi| 
 DËi t My Father is a skilled/expert 

 technician.  

43| QvÎ‡`i cÖwZw`b K¬vm Kiv DwPZ| 
 DËi t Students should attend the 

class  every day. 
44| evsjv‡`k GKwU ga¨g Av‡qi †`k| 

 DËi t Bangladesh is a country of 

middle income. 
 

 Fill in the blanks with correct word: 

45| To be healthy, we must eat - 

i. good food  (ii) rich food 

ii. balanced diet   

 DËi t balanced diet   

46| Move …..  you will die. 
 (i) and (ii) But (iii) or  

DËi t (iii) or 

47| That is ……… interesting book. 
(i) a (ii) an  (iii) the 

DËi t (ii) an 

 

 Answer the following questions in  

 short: 
48| Who is your Best Friend? 

 DËi t Sujon is my best friend. 
49| Where do you came from? 

 DËi t I am come from kushtia. 
50| What do you do after training ? 

 DËi t I will find a suitable job after 

 training. 
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 AwZ ms‡ÿ‡c DËi `vI t 
1| ROM- Gi c~Y© bvg ‡jL| 
 DËi t Read Only Memory 

2| MS Power Point Kx ai‡bi c¨v‡KR? 

 DËi t PowerPoint GKwU Presentation 

Software 
3| MS Word G Text alignment Kq cÖKvi †jL| 
 DËi t 4 cÖKvi 
4| MS Excel Program Default Column width KZ? 
 DËi t 8.43 Pixels. 
5| MS Word G Copy I Paste Gi Keyboard 

command †jL| 
DËi t Copy command: Ctrl+ C 

     Paste command: Ctrl+ V 

6| Print Preview Gi KvR Kx? 
DËi t †Kvb WKy‡g›U Print Kivi c~‡e© Zv  †`Lvi Rb¨ 
Preview e¨eüZ nq| 

7| GKwU B-‡gBj A¨v‡Wª‡mi mvavib MVb †jL| 

DËit B-‡gBj A¨v‡Wª‡m mvavib MVb njt <Userid> @ 

Domain name>.com  

8| MS Access program G Export Gi KvR Kx? 
DËi t MS Access n‡Z G‡·j G WvUv Kwc Kiv| 

9| PviwU I/O wWfvB‡mi bvg †jL| 
 DËi t (i) Keyboard  (ii) Mouse 

      (iii) Monitor (iv) Printer  
10| GKwU AvaywbK Kw¤úDUv‡ii cÖavb cÖavb Ask¸‡jvi bvg 

†jL| 
 DËi t (i) Input Unit (ii) Output Unit 

       (iii) CPU Unit  
 mwVK kã w`‡q k~b¨ ’̄vb c~iY Ki t  
11|   WWW Gi c~Y© bvg n‡jv ..........| 

 DËi t World Wide Web 

12| (28)10Gi evBbvwi gvb .................| 
 DËi t 11100 
13| MS Access GKwU .......... Program| 
 DËi t Database 
14| Primary Key - Gi  KvR n‡jv.........| 
 DËi t m¤úK© ˆZwi GKK BDwbU wn‡m‡e 
15| MS Word-G dvBj †mf Kivi KgvÛ n‡jv| 
 DËi t Ctrl+ S 
16| ....... Gi Kv‡R Query e¨envi Kiv nq| 
 DËi t WvUv‡em †_‡K kZ© Abymv‡i cÖ‡qvRbxq WvUv 

cÖ`k©b|  
17| Anti Virus ...... Gi Kv‡R e¨eüZ nq| 
 DËi t Kw¤úDUv‡ii fvBivm cÖwZ‡laK 
18|  1 wMMvevBU = ......... wK‡jvevBU| 
 DËi t 1000000  

19| RAM  n‡jv ....... Memory| 
 DËi t Random Access 
20| Kw¤úDUv‡ii ÿwZKi ‡cÖvMÖvg n‡jv ........| 
 DËi t fvBivm 
 

 evK¨wU mZ¨ n‡j ÔmÕ Ges wg_¨v n‡j ÔwgÕ †jL t 
21| File Gi bvg cwieZ©‡bi Rb¨ e¨eüZ nq Save As   

DËi t ÔwgÕ 
22| GKvwaK File Close-Kivi Rb¨ Exit e¨eüZ nq| 

DËi t ÔwgÕ 
23| MS Word G †Kvb wKQz gy‡Q †M‡j Undo Ki‡Z nq| 

DËi t ÔmÕ 
24| MS Word G  Convert e¨eüZ nq Data sort Kivi 

Rb¨| 
DËi t ÔwgÕ 

25| Application Program G File save Ki‡j Zv My 

Document G Save nq| 



 

 

DËi t ÔmÕ  
26| Line spacing Gi KvR Paragraph KgvÛ e¨eüZ 

nq| 
DËi t ÔmÕ 

27| Data move Ki‡Z e¨eüZ nq cut & paste KgvÛ| 
DËi t ÔmÕ 

28| E-mail ej‡Z Document ˆZwi Kiv †evSvq|  
DËi t ÔwgÕ 

29| Text Box Gi KvR n‡jv Text †K Color Kiv| 
DËi t wg_¨v 

30| Aå GKwU Language Program | 
DËi t ÔmÕ 

 mwVK DIiwU‡Z wUK (√) wPý `vI t  

31 |  MS Word Gi File Gi Extension Name n‡j- 
 (K) .exl  (L)  .dbs    

 (M) .doc  (N) .ms  

32 | Windows Kx ? 
 (K) Language Program 

    (L) User Program   

(M) Operating System Program            (N) 
Application Program  

33| Pen drive nj – 
 (K) I/O wWfvBm      (L) BbcyU wWfvBm 

 (M) AvDUcyU wWfvBm     (N) ‡KvbwUB bq 

34| †nWvi Ask Kx ? 
 (K) c„ôvi Dc‡ii As‡ki UvB‡Uj      
 (L) c„ôvi wb‡Pi As‡ki UvB‡Uj  
 (M) gvwR©‡bi wb‡Pi Ask        
 (N) †KvbwUB bq 
35| Accounting Gi KvR e¨eüZ Program n‡jv- 
 (K) MS Word (L) MS PowerPoint 

 (M) MS Access (N) MS Excel  

36| (a+b)2a  †jLvi Rb¨ e¨eüZ nq 
 (K) Format →Font →Subscript  

 (L) Format → Font → Superscript 

 (M) Format → Font → Outline 

 (N) Format → Font→ Emboss 
37| wcÖ›Uvi GKwU -  
      (K) BbcyU wWfvBm   (L) AvDUcyU wWfvBm  
      (M) I/O wWfvBm      (N) dvg©Iq¨vi 
38| Row & column †nwWs `„k¨gvb ivLvi Rb¨ e¨eüZ nq - 
      (K) Column width (L) Row height 

      (M) DfqwU      (N) Freeze panes  
39| B10 n‡Z B20 †m‡ji gvbgm~‡ni †hv‡Mi dvskb nj - 
      (K) =Sum (B10+B20)               
 (L) =Sum (B10.B20) 
      (M) =Sum (B10:B20)  

 (N) =Sum (B10;B20) 
40 | MS Word nj---- 
 (K) Spread Package   

 (L) Database Package   

 (M) Browsing Package 

        (N) Word Processing Package     

 

 Translate into English: 
41| evsjv‡`k Avgvi Rb¥f ~wg| 
 DËi t Bangladesh is my motherland 
42| †Zvgiv myLx nI| 
 DËi t May you be happy.  
43| Zywg Kv‡K PvI ? 
 DËi t Whom do you want? 
44| Avwg KvwiMwi wel‡q co‡ev|  
 DËi t I will study in technical subject. 

 

 Choose and fill in the gaps with the correct 

word/words: 

45| I am too…… to walk. (Weak/tight/quiet) 

DËi t Weak 

46| I will be …… technician (an/the/a) 
 DËi t a 

47| Teaching is ….. Profession. 

 (noble/good/honest) 

 DËi t noble 

 Answer the following questions in  short: 
48| Write down the name of your institute in 

English. 

 DËi t The name of my institute is  

 Deepnet Institute of Technology. 
49| What is your favorite hobby? 

 DËi t My favorite hobby is gardening. 
50| How old are you ? 

 DËi t I am 18 Years old. 
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    AwZ ms‡ÿ‡c DËi `vI t 
1|  Application Software Kx ? 
 DËi t e¨envwiK mgm¨v mgvavb ev Z_¨ 

cÖwµqvvKi‡Yi Rb¨ e¨eüZ †cÖvMvg‡K e¨envwiK 
†cªvMÖvg ev A¨vwcø‡Kkb mdUIq¨vi e‡j| 

2| Kq Bit-G 1 Byte ? 
  DËi t 8 Bit- G 1 Byte| 

3| Slid Animation cÖ`k©b Kivi KgvÛ Kx ? 
 DËi t F5 
4| W.W.W - Gi c~Y©i~c Kx ? 
 DËi t World Wide Web 
5| Operating System ej‡Z Kx eySvq ? 

DËi t Acvv‡iwUs wm‡÷g KZ¸‡jv Program Gi 
mgwó, hv †Kvb Kw¤úDUvi wm‡÷‡gi        
wi‡mvm©mg~n‡K wbqš¿Y, ch©‡eÿY I ZË¡veavb 
K‡i| A_¨vr Kw¤úDUvi cwiPvjbvi c×wZ‡K 

Operating System e‡j|  
6| GKwU Antivirus md&UIq¨vi Ges ỳwU 
 Input device- Gi bvg †jL| 

DËi t Antivirus Software- Kaspersky 
Ges ỳwU Input device: Mouse, Keyboard. 

7| Mail Merge Kiv ej‡Z Kx †evSvq ? 
DËi t GKB wPwV, †gBwjs †j‡ej ev weÁwß hw` 
wewfbœ wVKvbvq wfbœ wfbœ e¨vw³ ev     cÖwZôv‡bi 
wbKU cvVv‡bvi cÖ‡qvRb nq, ZLb D³ wPwVi mv‡_ 
wfbœ wfbœ wVKvbvq GK‡Î K‡i Lye Aí mg‡q c~Y©v½ 
wPwV MVb Kivi c×wZ‡K †gBj gvR© e‡j|         

8| BIOS Kx? 
 DËi t Basic Input Output System.  
9| MS Power Point Kx ai‡bi md&UIq¨vi? 

 DËi t Presentation Software| 
10| †¯úªW kxU ej‡Z Kx eySvq ? 

DËi t gvB‡µvmdU G‡·j n‡”Q †¯úªWwkU 
Av¨vbvjvBwmm †cÖvMÖvg|  

 mwVK kã w`‡q k~b¨ ’̄vb c~ib Ki t  
11| Legal Size KvMR n‡”Q .......| 
 DËi t 8.514 
12| SQL- Gi c~Y©iyc nj ........... ? 
 DËi t Structured Query Language 
13| CPU n‡”Q ....................... ? 
 DËi t Central Processing Unit . 
14| ¯‹¨vbvi n‡”Q GKwU .............. wWfvBm| 
 DËi t Input Device 
15| Kx †ev‡W©i dvskb ÔKxÕ ................ wU| 
 DËi t 12 wU 
16| Data sort .............. cÖKvi| 
 DËi t 2 cÖKvi  
17| ROM Gi c~Y©iæc ...................| 
 DËi t Read Only Memory  
18| Undo Kivi Rb¨ mswÿß Command n‡jv .....| 
 DËi t Ctrl + Z  
19| Computer-Gi cÖ_g †cÖvMªvg iPwqZvi bvg...  
 DËi t †jwW A¨vWv AvMv÷v| 
20| MS Power Point GKwU ........ Software| 
 DËi t Presentation 
21| RAM Gi c~Y©iæc .............| 
 DËi t Random Access Memory. 

22| A4 mvBR KvM‡Ri cwigvc n‡”Q .......| 
 DËi t 8.2711.69 
23| Excel Row msL¨v................ wU| 
 DËi t 2003 fvl©‡Y t 65536 wU Ges  

   2007 fvl©‡Y t 108575 wU| 
24| Recycle Bin †dvìv‡i .... dvBj Rgv _v‡K| 
 DËi t gy‡Q †djv| 
25| ¯‹¨vbvi GK cÖKvi .................. wWfvBm| 



 

 

 DËi t BbcyU wWfvBm| 
 
 evK¨wU mZ¨ n‡j ÔmÕ Ges wg_¨v n‡j ÔwgÕ †jL t 
26| Computer-Gi Virus GKwU RxevYy| 

DËi t mZ¨ 
27| Folder-Gi †fZ‡i File I Folder DfqB 

_vK‡Z cv‡i| 
 DËi t mZ¨ 
28| Hard disk GKwU Processing wWfvBm| 
 DËi t wg_¨v 
29| Windows GKwU Application Software| 
 DËi t mZ¨ 
30| Pen drive †K d¬vk †g‡gvwi ejv nq| 
 DËi t mZ¨  
31| Cut Kivi ÔKxÕ-†evW© KgvÛ Ctrl+X | 
 DËi t mZ¨ 
32| Google  GKwU mvP© BwÄb bq| 
 DËi t wg_¨v 
33| †gBj A¨vKvD›U eÜ Kivi Rb¨ Sign in -G wK¬K 

Ki‡Z nq|  
 DËi t wg_¨v 
34|  A-Z wbD‡gwiK Key| 
 DËi t wg_¨v 
35| RAM GKwU ’̄vqx †g‡gvwi| 
 DËi t wg_¨v 
36|  IqvK©kxU IqvK©ey‡Ki Ask we‡kl | 
 DËi t mZ¨ 
37| Data sort ỳB cÖKvi | 
 DËi t mZ¨ 
38| Mother board Kw¤úUv‡ii cÖwµqvKiY Ask 
 DËi t wg_¨v 
39| MS-Power point w`‡q Presentation ‰Zwi 

Kiv nq| 
DËi t mZ¨ 

40| Save-Gi ÔKxÕ- †evW© KgvÛ Ctrl+P. 

DËi t wg_¨v 
 mwVK DIiwU‡Z wUK (√) wPý `vI t  

41 | Undo-Gi ÔKxÕ-†evW© KgvÛ †KvbwU ? 
 (K) Ctrl + c; (L)  Ctrl   + p ;    

 (M) Ctrl + v; (N) Ctrl + z  

42 | Data base ‡cÖvMÖvg- 
 (K) Word perfect;   (L) MS-Excel;   

 (M) MS-Word;           (N) MS-Access;  

43| weRq Pvjy Ki‡Z Pvc‡Z nq – 
 (K) Ctrl+Shift+B ;    (L)Ctrl+Alt+B;  

 (M) Ctrl+Ait+A ;       (N) Ctrl+B ; 

44|  GK wK‡jvevBU mgvb KZ ? 
 (K) 1024 evBU;     (L) 1014 evBU ;  
 (M) 1124 evBU ;       (N) 1011 evBU ; 
45|  LAN k‡ãi c~Y©i~c †KvbwU ? 
 (K) Local Area Network     

 (L) Lokal Area Network ; 

 (M) Local Assemevle Netwoek ;  

 (N) Legal Assemble Network ; 

46| ICT- Gi c~~Y©iƒc †KvbwU ? 
 (K) Information Communication                    
 and Technology; 

 (L) Information and Communication  

 Technology;  

  (M) Information Computer Technology; 

 (N) International Commercial Trading  
47| File Close-Gi ÔKxÕ- †ev©W KgvÛ †KvbwU? 
      (K) Ctrl + O ;          (L) Ctrl + W ;   

       (M) Atl + O ;            (N) Ctrl + F4 ; 
48| wb‡Pi †KvbwU mnvqK †g‡gvwi? 
      (K) Hard Disk ;     (L) Floppy disk ;  
      (M) CD-Rom ;          (N) Cache ; 
49| Print-Gi kU©KvU KgvÛ †KvbwU? 
      (K) Ctrl + Y ;       (L) Ctrl + X ; 
      (M)  Ctrl + P;     (N) Ctrl + Z ; 
50| GKwU wd‡ìi bvg wjL‡Z KqwU K¨v‡iKUvi e¨envi 

Kiv nq? 
      (K) 40wU ;              (L) 33wU ; 
      (M) 21wU ;               (N) 64 wU ;  
 Translate into English: 
51| XvKv eywoM½v b`xi Zx‡i Aew¯’Z| 

DËi t Dhaka stands on the Buriganga. 
52| Avwg †`k‡K fv‡jvevwm| 
 DËi t I love my country. 

53| †Zvgvi gvZvi bvg Kx? 



 

 

 DËi t What’s your mother name? 
54| Avwg GKRb `ÿ KvwiMi n‡ev| 
 DËi t I shall be a skilled technician.  
 Answer the following questions in  English: 
55| How old are you ? 

 DËi t I am 18 years old. 
56| What is the capital of Bangladesh. 

 DËi t The capital of Bangladesh is   

Dhaka. 
57| Where are you working ? 

 DËi t I am working in a factory. 

 Fill in the blanks with correct word: 

58| Bangladesh became 

independent……………. 
iii. 1947   (ii)1991 

iv. 1971    (iv)1972 

 Ans: 1971 
59| …..a letter to your father. 
 (i) Make (ii) Read (iii) Write 

60| He is ………..honest man. 
 (i) an  (ii) a  (iii) the     

Ans: an 
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 AwZ ms‡ÿ‡c DËi `vI| 
1. dvBj I †d¬vWvi wK? 

DËit dvBjt hLb †Kvb Document-†K †Kvb 
bvg w`‡q msiÿb Kiv nq, Zv‡K File e‡j| 
†dvìvit †dvìv‡ii g‡a¨ dvBj ivLv nq| ZvQvovI 
†dvìv‡ii g‡a¨ †dvìviI ivLv hvq , G‡K mve-
†dvìvi e‡j| 

2. `ywU RbwcÖq (Search Engine) Gi bvg †jL? 
 DËi t (i) Google (ii) Yahoo 
3. B-†gBj(E- Mail) A¨v‡Wª‡mi wewfbœ Ask¸‡jv 

wPwýZ Ki|  
 DËi t B-‡gBj A¨v‡Wª‡mi mvaviY MVb nj t 
<Userid> @ Domain name>.com|  

4. †mj A¨v‡Wªm Kx ? 
DËi t IqvK©kxU Gi cÖwZwU Ni‡KB †mj (Cell) 
ejv nq| †mj mg~‡ni A¨v‡Wªm wba©viY Kiv nq †iv 
I Kjvg Øviv| A_©vr †iv I Kjvg Øviv †Kvb †mj‡K 
wbY©q Kiv‡KB †mj A¨v‡Wªm ejv nq| 

5. †nvg ‡cBR wK ? 

 DËi t GKwU I‡qe †cBR Gi cªv_wgK ev cÖavb 
†cR n‡”Q †nvg †cBR| I‡qe †cB‡Ri me ai‡bi 
mswÿß weeiY _v‡K GB †nvg †cB‡R| 
6. B-†gBj Gi †ÿ‡Î  CC I BCC Gi gv‡S cv_©K¨ wK 

? 
 DËi t CC Gi c~Y©iƒc Kve©b Kwc Îes BCC Gi 
c~Y©iƒc eøvBb Kve©b Kwc| CC Gi gva¨‡g †Kvb †gBj 
†cÖib Ki‡j †mLv‡b †mìv‡ii B-‡gBj A¨v‡Wªm †mv 
Ki‡e| wKšÍ BCC Gi gva¨‡g †Kvb B‡gBj †cÖib Ki‡j 
†mLv‡b ‡cÖi‡Ki A¨v‡Wªm ‡mv Ki‡e bv| 
7. †U·U G¨vjvBb‡g›U Kq ai‡bi I  Kx Kx ? 
 DËi t 4 cÖKvi| 
8. d‡ib ÔKxÕ (Foreign key) ej‡Z Kx ‡evSvq? 
 DËi t  d‡ib Kx (Foreign key) GKwU Table 

Gi cÖvBgvwi Kx hLb Ab¨ †Uwej Gi †Kvb Key  Gi 
mv‡_ wi‡jkb ˆZwi K‡i ZLb Ab¨ Table Gi †mB 
key †K Foreign key e‡j| A_©vr Primary key 

hvi mv‡_ wi‡jkb m„wó K‡i †mB key n‡jv Foreign 

key | 
9. Save I Save As Gi cv_©K¨ wK ? 



 

 

 DËi t †Kvb WKy‡g›U ˆZwi Kivi ci †mwU‡K cÖ_g 
ev‡ii gZ †mf Ki‡Z PvB‡j Save as e¨envi Kiv 
nq| Avi c~‡e©i gZ WKz‡g›U G bZzb †Kvb Ae‡R± 
ms‡hvM Kivi cÖ‡qvRb n‡j ZLb Save e¨envi nq|  
10. Pen drive-†K I/O wWfvBm ejv nq †Kb ? 
 DËi t ‡cb WªvBf Kw¤úDUv‡ii GKwU mnvqK 
†g‡gvwi wnmv‡e e¨envi Kiv nq| Gi mvnv‡h¨ WvUv 
BbcyU AvDUcyU Kiv hvq, GKB mv‡_ BbcyU I 
AvDUcy‡Ui KvR K‡i e‡j Pen drive-†K I/O wWfvBm 
ejv nq| 
11. BIOS ‡cÖvMÖv‡gi  KvR wK ? 
DËi t Basic Input Output System. 

12. weU I evBU  ej‡Z wK †evSvq? 
 DËit weUt evBbvix bv¤^vi cØwZ‡Z e¨eüZ AsK 0 
(k~b¨) Ges 1 (GK) †K weU e‡j| 
 evBUt AvU we‡U GK evBU nq| Giƒc 8 we‡Ui 
†KvW w`‡q †h-†Kvb eY©, A¼ ev we‡kl wPý‡K  cªKvk 
Kiv n‡q _v‡K|  
13. †n·v‡Wwmg¨vj bv¤^vwis wm‡÷g ej‡Z wK †evSvq ? 
 DËit  †n·v‡Wwmg¨vj bv¤̂vit †n·v‡Wwmg¨vj 
msL¨vi wfË nj 16 wU| G‡Z 16wU AsK Av‡Q,  †hgb-
0,1,2,3,4,5,6,7,8,9,A,B,C,D,E I F| 
 

 mwVK kã w`‡q   k~b¨ ’̄vb c~iY Kit 
14. BIOS- Gi   c~b©iƒc ----------| 
 DËi t Basic Input Output System. 
15. ---- †K AvaywbK Kw¤úDUv‡ii RbK ejv nq | 
 DËi t Pvj©m e¨v‡eR 
16. RAM GKwU ------- †g‡gvwi| 
 DËi t A¯’vqx 
17. Windows GKwU   ------- mdUIq¨vi| 
 DËi t Acv‡iwUs wm‡÷g 
18. A±vj msL¨v  c×wZi †em n‡jv---------| 
 DËi t 8 
19. B- †gBj G¨vKvD›U eÜ Kivi Rb¨ ----wK¬K Ki‡Z 

nq|  
 DËi t Sign out 

20. OMRGKwU   ---------- wWfvBm| 
 DËi t AvDUcyU 
21. WvUvi Mogvb wbY©‡qi Rb¨------dvskb e¨envi 

Kiv nq| 

 DËi t Average 

22. Record nj  KZ¸‡jv --------- Gi mgwó| 
 DËi t Field 

23. A4 KvM‡Ri mvBR---------------| 
 DËi t ‰`N©¨ 11.69’’, cÖ¯’ 8.27’’ 
24. Word Processing- G evbvb ï× Kivi Rb¨ ---

-- †gb¨y e¨envi Kiv nq | 
 DËi t Tools 

25. ----- Kw¤úDUv‡ii mKj  cÖKvi jwRK I MvwYwZK   
KvR K‡i _v‡K|  

 DËi t  gvB‡µv    
26.  Past Gi Keyboard KgvÛ Av‡Q-------|  
 DËi t Ctrl + V 
 
 evK¨wU mZ¨ n‡j  m Ges wg_¨v n‡j wg †jL| 

27. Super VLSI wPc I AcwUK¨vj dvBev‡ii mgš̂‡q  
cÂg  cÖR‡b¥i Kw¤úDUvi ˆZwi| 
DËi t mZ¨  

28. Kwc †c÷ I KvU †c÷- Gi gv‡S ‡Kvb cv_©K¨ 
bvB| 
DËi t wg_¨v 

29. gvB‡µvKw¤úDUv‡ii g~j Ask n‡jv 
gvB‡µvc ª‡mmi| 
DËi t mZ¨ 

30.  †dvìv‡ii wfZi dvBj I ‡dvìvi DfqB _vK‡Z 
cv‡i| 
DËi t mZ¨ 

31. Recycle bin-Gi WvUv cybivq wd‡i Avbv hvq bv| 
DËi t wg_¨v 

32. IqvK©kxU IqvK©eyK‡i Ask we‡kl| 
DËi t mZ¨ 

33. Ctrl+Alt+B ÔKxÕ-†evW© evsjv-Bs‡iwR †gv‡W 
cwieZ©‡bi Rb¨ e¨eüZ nq  | 
DËi t mZ¨ 

34.  †U·U e‡· †jLv hvq bv| 
DËi t wg_¨v 

35. weRq GKwU evsjv d‡›Ui bvg| 
DËi t wg_¨v 

36. SQL †cÖvMÖvg IqvW©  cÖ‡mwms  Gi Kv‡R e¨eüZ 
nq|   
DËi t wg_¨v 



 

 

37. Page  Setup  dvBj †gby¨i GKwU  Option 
DËi t mZ¨ 

38. wd‡ìi mgwó n‡”Q ‡iKW©| 
 DËi t mZ¨ 
 

 mwVK DËiwU‡Z wUK wPý `vI| 

39. MS- Word G Undo Gi ÕKxÕ- †evW© KgvÛ 
†KvbwU? 
(K)  Ctrl+X      (L) Ctrl+Z          
(M)   Ctrl+O     (N) Ctrl+F4  

40. wb‡Pi  †KvbwU mnvqK †ggwi bq? 
(K)  Floppy Disk (L) Hard Disk  
(M)  Cache  (N) CD-ROM   

41. wb‡Pi †Kvb KgvÛ Equation †jLvi Rb¨ e¨eüZ 
nq  ?  

(K) File-Object-Microsoft Equation 
(L)  Insert- Equation                     
(M)  View-Equation                
(N)  Insert-Object-Microsoft Equation    
42. MS-Access Gi   Print File †K Kx ejv 

nq? 
 (K) Form File  (L) Report File    
(M) Query File  (N) Table 

43. (29)10  msL¨vwUi evBbvwi msL¨v KZ? 
 (K) (11011)2      (L) (1110)2   
 (M) (11101)2     (N) (10111)2    
44. WvUv‡e‡mi  ÿy`ªZg  Ask‡K Kx ejv nq? 
 (K) File  (L) Record      
 (M) Field  (N) Table       
45. †KvbwU Logical Function? 

 (K) =IF  (L) =Sum   
 (M)  AVG (N)  MOD()                                                                      
46. B›Uvi‡bU  Connectivity -Gi bvg bq †KvbwU? 
 (K)  Dial Up        (L) Yahoo       
 (M)  Broad band   (N) Wireless                                                           
47. Microsoft Excel G  Column KqwU? 
 (K) 256 wU    (L) 265 wU     
 (M) 165 wU  (N) 365 wU                                               
48. wb‡Pi †KvbwU †cBR †mU Avc (Page set up) 

Kivi KgvÛ? 

       (K) File-Page set Up (Margin paper Size)ok     
       (L) Eidt-Page set Up (Margin paper Size)ok  
       (M) View-Page set Up (Margin paper Size) ok                             
       (N) File-Page set Up (Margin paper Size) ok    
49. †KvbwU A¯’vwq †g‡gvwi? 

(K) ROM  (L) HDD   
(M) CD -ROM  (N) RAM    

50. C6 †_‡K D6 ch©šÍ  Data¸‡jv †hvM Kivi 
KgvÛ- 

 (K)  ADD(C6:D6)  (L) ADD(C6-D6)    
 (M)  SUM(C6:D6)    (N) SUM (C6-D6)                              
 

 Translate  in to  Eng lish : 
51. XvKv evsjv‡`‡ki  ivRavbx| 
 DËi t Dhaka is the capital of 

 Bangladesh. 

52. Avgvi evev GKRb  `ÿ KvwiMi| 
 DËi t My father is skilled technician. 

53. iwng †ivR ¯‹z‡j hvq| 
 DËi t Rahim goes to school regular. 

54. e„wó co‡Q| 
 DËi t It is raining. 

 Fill in the blanks: 

55. They------------- playing football 

 DËi t are 

56. My mother is -------- honest women 

 DËi t an 

57. Put-------- the lamp 

 DËi t off 

Answer the following  question English: 

58. Where do you  live? 

 DËi t I live in Rajshahi. 

59. What  is  your   father? 

 DËi t My father is a technician. 

60. Which  trade  do you read in? 

 DËi t I read in Refrigeration. 

 


